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* A global semiconductor leader

« 2017 revenues of $8.35B with year-
on-year growth of 19.7%

- Listed: NYSE, Euronext Paris and
Borsa ltaliana, Milan

_WhoIs ST

® Research & Development
@ Main Sales & Marketing
® Front-End

® Back-End

« Approximately 45,500 employees worldwide

« Approximately 7,400 people working in R&D
« 11 manufacturing sites : }'
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ST. Products & Ecosystem
to Match loT Market Trends

Smart T'\ : Smart o | Smart :
Things & City : Industry  E-—"07 i
ATEHeT 995k, O Wi, BTLE, S.Ub'GHZ’ LTE, Sub-GHz, Motion Longevity, Certification,
Sensors, Audio, Touch, :
Graphics. .. Sensors motion sensors...

Factor, Sensors
Ecosystem for application development

Market Trends

Performance...

Broad Technology Offer A

STM32 Nucleo
expansion boards
for connectivity,
sensing, actuating
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Form Factor Boards
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Move /
Actuate

(%) STM32 Nucleo
development kits
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The loT Trend =

Any system able to leverage the Internet and its ecosystem

Nodes Gateways
(Billions) (Millions)
i
! Servers
Smart (Big data & cloud)
Things & Network infrastructure

Applications Smartphone (Switch / Router)
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loT Devices Come in Many Form Factors
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Sensing & Processing Connectivit Signal Conditioning
Actuating & Security y & Protection

Full range of
sensors
and
actuators

A

..but Their Needs are the Same ==

—
lll

Ultra-Low Power
to
High Performance

Scalable Security
solutions

Nano Amps
to
Kilo Amps

®



MEMS and Analog Empower the 10T =
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Sense Actuate Sensor Power Signal Connectivity Security Processing
Interface Conditioning

MEMS Digital
.

Today only a tiny portion of the sensory data that would be useful is captured, stored and analyzed

...and even smaller part of that is used to carry out actions through actuators
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Connect a

Translate =/3

Move (@@

Actuate

&0

Process

Sense

g
HEH

Supporting the loT Movement

B
SensorTile

STM32 Nucleo Development
& Expansion boards

Pre-integrated SW for vertical applications

Smart Things Smart Home Smart City Smart Industry

Development Ecosystem

W @ &

Code generators  Prototyping Development
software environments
Debug Simulation On-line

solutions and analysis tools  design tools

ST
Community
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ST as Sensors & Actuators Supplier

&

Market-proven Manufacturing High Volume Expertise in Leading Smart | Key Partnerships
Technologies Manufacturing multi-sensor Functions in product
Front-End / Back-End/ Testing & Calibration Integration Integration development
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20 Years of MEMS at ST

+

Accelerometer Inertial Pressure Micro-mirror Piezo Water Proof
module sensor actuators actuators Pressure
“ : S sensor
3 0%
Fluidic Gyroscope Magnetometer Microphone Humidity GAS & VOC
Micro-actuators sensor
2000 2005 2010 2015 2017 2018

O\ O o o o o (]

»

Smart Home & City

Smart Things Smart Driving




Smart Industry

000

Industrial Appliances Building Medical Defense Navigation
automation

/ ST Longevity Program Benefits \

EXTENDED
10-YEAR DESIGN AND CALIBRATION & TEMPERATURE
LONGEVITY FROM MANUFACTURING TESTING FOR RANGE AND

PRODUCT FOR HIGHER HIGHER
ENDURANCE TO
INTRODUCTION ROBUSTNESS & ACCURACY & SHOCK AND
DATE PERFORMANCES QUALITY VIBRATION
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/ Cortex-MO0

STM32 portfolio positioning

12 product series / More than 800 Parts

More than
40,000 customers

Cortex-M7

Cortex-M3 / Cortex-M4

/ Cortex-MO0+

Note

: Cortex-M0+ Radio Co-processor
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HW Development Tools

Evaluation STM32 Nucleo

STM32 Nucleo Discovery kits boards eXxpansion

Third-party boards

Flexible Key feature Full feature Functionality From full evaluation to open
prototyping prototyping evaluation add-on hardware

www.st.com/stm32nucleo www.st.com/stm32discovery www.st.com/stm32evaltools www.st.com/x-nucleo
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An Application-Oriented Approach

Processor boards (Nucleo 64) Function Packs (FP)
Expansion boards (X-NUCLEO)

Sensors

h Connectivity
=3 Translate
(@@ Motor drivers

Application software Integrated Development Environment Ready-to-use
and development tools and middleware application-oriented package

Op Amp

Motor controller
Microcontroller

=t %2
b Rt

ZE

5
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Development Software Architecture

Mobile app prototyping & cloud prototyping

Sample applications | Function Packs

STM32Cube
__________ Hardware Abstraction Layer (HAL)

s
). _ STM32 Nucleo STM32 Nucleo
B Development boards Expansion boards

i n o E

'S @ n!

L2 & = STM32Cube expansion SW °

S High-value middleware @Y® STM32 Open
{1 £ §,§ STMs2Cube . - & S Development

i L%;é = | el BEE STM32Cube . Environment

' 28 g, Expansion HAL

1 O £ 1

038
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Development Software Architecture

Mobile app prototyping & cloud prototyping

STM32Cube
__________ Hardware Abstraction Layer (HAL)

s
. _ STM32 Nucleo STM32 Nucleo
B Development boards Expansion boards

o Sample applications | Function Packs Lsing AlgoBuilder

2% | P——

S ouw. STM32Cube expansion SW ‘ @ c
. é g é STM32Cube High-value middleware

i 3% “E’ i middleware STM32Cube Sensor and Audio Algorithm Software

1 2§ g Expansion HAL

 ©E

28
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AlgoBuilder

An application for the graphical design and testing of algorithms

e e
== Code
20800 generation

Existing algorithms GUI quickly elaborates proto applications AlgoBuilder
. : for eases the process of
User-defined data processing MEMS sensors molementin
blocks P g
Additional functionalities and proof of concept
STM32 microcontrollers without writing the code
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AlgoBuilder Overview
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| AlgoBuilder

~ - Overview
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Logic Operators

Vector Operations

Math Operations [Free FalDetecter Output Pins:
VeotlomaiN out (void x 1):
ot Sensor Hub handler.
MotionGC -
Hotioni) Data Rate (int):
MotionhC Defines the sensor's and agorthm's data rate in Hz:
MotionPW Range: <1, 400
Othar A[celﬂrum?’:er Fu\I‘SG\e (int): v
Sensor Hub Defines the accelerometer ful scal.
Signal Values: 16 g, 29,4 0,80
gal Gyrascope Ful e (in)
Jomperatine nes the gyroscone fullscal.
User Input. Values: 1000 dps, 2000 dps, 245 dps, 500 dps

& x Description 8%
Comparson [Sensor Hub] _
Constants Version: 1.0
Display Sensor Hub provides finks to sensor and algorthms n order
Graphics to retrieve data from them.

Propertes 8 x
Pils
GEnerail Mame Value Type

Data Rate 100

Accelerometer Ful Sale [4.g

Gyroscope Full scale
< >
Corsole. %

x:479.6 y:49.5 z00m: 0,809081

GRAPHIC DESIGN

RESULT
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AlgoBuilder
Overview
AlgoBuilder is an application for the graphical design of algorithms.

The main objectives of this application are:
« Quick prototyping of applications for STM32 microcontrollers and MEMS sensors which include already existing algorithms (i.e.
sensor fusion or pedometer), user-defined data processing blocks and additional functionalities.
+ Ease the process of implementing proof of concept using graphical interface without writing the code.
«  Visualize the data on Unicleo-GUI in real time using plot and display.

« The main feature of this application:
« Simple graphical design (drag and drop, connect, set properties)
* Awide range of function blocks are available in libraries including motion sensor algorithms.
« Customize function blocks. Open XML for function blocks and design storage.
« C code generated from the graphical design.
»  Support for various compilers: SW4STM32 (GCC), IAR EWARM, Keil uVision.
+ Outputs from generated firmware can be displayed in Unicleo-GUI application.

Lys
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AlgoBuilder

Version 1.5

The new features in version 1.5:

» Unlimited number of display charts and inputs values

* New displays (Bar, Scatter, 3D plot, Tea pot, Histogram)

» Search box in library dock

» Hide unused items in properties dock

» Node names based on function block output name

» Function block version control and automatic conversion to the newest version
» Function block creator (GUI)

» More function blocks

» Support for SensorTile (STEVAL-STLKTO01V1)

» Update based on the feedback from version v 1.0

Lys
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AlgoBuilder

Principle

AlgoBuilder 1. Make your design

GUI

AMEData | conversion

Engine
C code 3. Uploads to your
development board

Lys
: sese o5 NUCLEO
re N
. G a¥s»
5_HEe Y v
.

FW Template - F;;‘::}I;i:e #

t SIAR >|KEIL

- 2

4. Display sensor
data in Unicleo-GUI

STV 12 >1KE

Librari 2. AlgoBuilder compiles
(Li:"arr'e)s your design through
Y external compiler
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Environment Setup
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Prerequisites: Software

 AlgoBuilder: Application for the + AlgoBuilder uses external compiler
graphical design of algorithms to build the FW.
It is mandatory to have available at least one of
: the IDE if you want to compile a project.
+ Unicleo-GUI y Prie & prol
The Unicleo-GUI is used to display outputs » Supported IDEs
from the running FW generated by the System Workbench for STM32 v1.13.1 or
AlgoBuilder newer

SIAR . |AR EWARM 7.80.4 or newer
P|KEIL «  Keil uVision 5.22 or never

STM32 ST-LINK utility

STM32 Virtual COM Port Driver

Lys
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Key features:
» Display output data from connected sensors in various views (X-NUCLEO-IKS01A1, X-NUCLEO-IKS01A2)

» Display outputs from algorithms

« Save data to comma separated (CSV) or tab separated (TSV) files
» Configure sensor output data rate and full scale
» Direct read from and writes to sensor registers
» Program NUCLEO board with selected FW

Unicleo-GUI

X-CUBE-MEMST

& Unicleo-GUI

& Unicleo-GUI

- x - X
Selet e |OOME . 4 Coret &Y Disconnect. ‘ I Start o | L Settings. ‘ X Ext Select Device: | GORI0Z (G0:23:3LAF 72:40) ¥ Connect # Dsopmnest ‘ tart Stop | ) Settings | K edt
Info  FWManagement  UserMessages  IXSO1A2Options ffo  FWWMansgement  User Messages
DH‘ ~— Accelerometer - LSM6DSL —— Pressure - LPS22HB Selected Firmware Info -
I s s . OO aNS
[6asoeos SRS e =) 2
wvoton | Full Scale: |8 = Value:[ ] | Y : AHHAE : i Full Scale: F Value:[ -] Firmitare Versiont: 501A2 k50142 Tkso1a2 KSU1A2 Ks01a2 IKS01A2 KSOLA2
MEMS At mmm ActiveTime_| 7 D g
ODR:|416 = Get Sat 0ODR:|75 ¥ Get Sat 218 calibratio KSG1A2.0in gnition_{KS anitionWris. n_KS01AZb  ded [KSO1A2  ded XTI_IKS n_lksoiAzb
=8 =) @& =) @ Library Version: ol lrsmua 0142.5in Liksoiazb in bin 01A2in in
Em-wg ) ST MotionAC v2.1.0 "
bl Gyroscope - LSM6DSL ——— Humidity - HTS221 Expansion Board:
s‘:; Enable: Address: - Enable: [ Address: - N”f"l:zd ﬂ @ r ) m n
f ks Baard: b
Full Scale: [1000 > Value: = Full Scale: 2 Value: ¥ STMIASTERG 5012 k50142 n(ﬁnz KS01AZ k50142 1KS01A2 k50142 KsniAz
- = o = 2 ECompass_[KS  FallDetectio  FFT_Demaubin  FitnessActiv R cog  GyroscopeCal t RyD et Magm rm er
ODR:IH0 =) set) ORI Get) (set) Main fuicton s to show how to use olAZbin  nKSOiAZb WehoT o ST neaion. Ik n kS0
X_MUCLEQ msufm;(jémm r boerd for in AZbin 1AZbin SO1AZbin “i2oin \KSNAZ o
demanstration of a ter calioration,
— Magnetometer - LSM303AGR — Temperature - HTS221 —
Enable: Address: - Enable: [1 Address: =
Full Scale: |50 g Value: ~ Full Seate: E Value: -
KE01A2 50142 TKSD1AZ TKS01A2 K&01A2
obr:[50 7] Get set ) messsnssese opR:[125 =] Get ) | Set) pedameter Ik i Tiitsensing.
e S01A2bin sLIKSOIAZ  on IKSO1A2.  ingDesk KS  |KSOtAZbin
[ Comm—— | b bir D142, bir
Enable All Sensors [ Disable All Sensors " " "
- Muden Drive Not Found el
~ R
STMicroglectronics- Unicléo Version: 1.4.2.5856 Firmware Version = 4.0.0 Expansion Board: IKSD1AZ STMicroslect: nics Urideo Version: 1.4.12.6746 Firmuare Version = v0.0.0 Expansion Board:
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= X-CUBE-MEMST

HI coeffi 105 mGauss

HI coefficient Y. -84 mGauss

HI coefficient Z: <439 -mGauss
dness;

ST matrix[0][0]: 1,405

ST matrix[2][d]: 0
SImatrix[2][1}: D
SI matrix[2][2]: 1,50
£ 100 am;

€3 Fitness Activities

" - - Time Activity Counter fvity:
248 Magretometss Scaer lot 06:30:44.00 BicepsCurl 00 Current Activity:
e < § 09:29:50.07 BicepsCurl @1 ol
: 08:30:54,07 Biceps Curl 02 Push-up
; 02:30:55.96  Sguat i} Count: 01
08:40:01.52 Sguat 03
[ - | (T Push-up a0
Data Vafid: 1 Push-Lp om

Vertical Context: Escalatc
Context Confidence: Poor

100 mG

(®) Sensor Fusen 9x ) Sensor Fusion 6x Resst model
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Prerequisites: Hardware

Nucleo Development & Expansion Sensor Tile
Boards
- NUCLEO-F401RE or NUCLEO-L476RG * The development kit simplifies prototyping,
evaluation and development of innovative
- X-NUCLEO-IKS01A2: Motion MEMS and solutions.

environmental sensor expansion board for
STM32 Nucleo

SensorTile kit
Connectable sensor node
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Motion MEMS and environmental sensor expansion board

X-NUCLEO-IKS01A2 Hardware Description

* The X-NUCLEO-IKS01A2 is a motion MEMS and environmental
sensor evaluation board system.

* It is compatible with the Arduino UNO R3 connector layout, and is
designed around ST’s latest sensors.

H
|
|

®
®
®
®
olf
of
© o
.
!

Key Product on board

MEMS 3D accelerometer (+2/+4/18/+16 g) + 3D gyroscope
(£125/+245/+500/+1000/+£2000 dps)

MEMS 3D magnetometer (+50 gauss) + MEMS 3D accelerometer

(£2/14/£8/£16 @)
o [Cse14  see[d] = R
MEMS pressure sensor, 260-1260 hPa absolute digital output barometer N | [rvcieo-ioras) el v - 3
| ] HTS221 LSM6DSL ST morpho connector**

Capacitive digital relative humidity and temperature .
Socket available for additional MEMS adapters and other sensors (UV index) [[]LPs22HB[] LSM303AGR([ | Arduino UNO R3 connector

[ ] DIL 24-pin

N\
Latest info available at www.st.com
X-NUCLEO-IKS01A2

Lys
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SensorTile Platform

STEVAL-STLKT01V1 Hardware Description

« STEVAL-STLKTO1V1 is the development kit for the SensorTile board (STLCS01V1), a highly Integrated Development
Platform with a broad range of functionalities aiming to improve system design cycle and accelerate delivery of results

SensorTile Core System
STLCS01V1
13.5mm

Digital Mic

SensorTile Cradle expansion
STLCX01V1

Antenna
Clearance Area

N

sl |- BALF-NRG-01D3

STM32L476

-
v
-
<
-~
-
&
il

13.5mm

SensorTile Cradle
STLCRO1V1

LSM303AGR LPS22HB

Lys
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AlgoBuilder ___

1. Run install.bat as administrator. Installation

=B Es e L
Home Share View Manage n o
- {, ot = T haw item = n [ open Select ail
[ ¢ ¢ B X=f 32 g moo- B
i Copy path A F | Easyaccess = — | | Edit i Select niane
ek Topy  Paste Move Copy  Delefe Rename New Praperties o
' Iﬂ Paste shartcut tor  to- - folder - 45 Histary E’J: Invert selection
Clipboard Organize New Open Select
& v A v USBDISK (D) w @ Search USBDISK (D) o
Name Diste modified Typs Size
# Quick access
data 2018 1006 AM  File folder
This PC ' documents 5/31/201810:10AM  Fil= folder
| _install.bat . Batch File 2KB
=] _uninstall.bat = Bstch File P KE
G install_swdstm32 win_ 326 oy ) 452,225 i
Q install_swadstm32 win_6db rr.n [ I
¥ Run as administrator s
&l Pictures 7-Zip >
[ videos CRC SHA >
e Windows [C) g Edlit with Notepad++
 USBLDISK (41 £ Scan with Windoivs Defender,.,
= DATA (Vignx324Q.gnk.st.com) (1) Scan forViruses...
= AMIDATA (\gnx3%42.gnk.st.com) (L) A Convert with PDFCreator
= PRI (\\gnx5248.gnb.st.com] (W) @ TortoisesVN >
=g p_memsdocs (\ctofs0D8s.cto.st.com) (¥:) @ Wi e
== Superisory (\\agrfs004b.agr.st.com\prg_amsiaoclab\Projects) (Z:)
Send to >
JSE_DISK (D
5B (B:) Cut
¥ Network Copy
Paste
Create shortcut
Delete
Rename
r Properties
’ ’ b items 1 item selected 1.46 KB
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|
Installation

2. Confirm Device Drivers installation.

Device Driver Installation Wizard Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some

uters devi d in order to work.
EOMPULEMS evISes NSeg n erderia wo The drivers were successfully installed on this computer.

You can now connect your device to this computer.  your device
came with instructions, please read them first.

Driver Mame Status

v STMicroelectronics (Win... Ready to use
v STMicroelectronics (usb... Ready to use

To continue, click Next.

N Cancel < Back I Cancel

This will install ST-Link and Virtual Com Port Drivers.

(2]
2

Lys
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3. Remove USB and open C:/AlgoBuilderinstall/ folder.

Run install sw4stm32 win 64bits-v2.4.exe as administrator.

AlgoBuilder

Installation

= | Application Tagls

View.

Home Share Manage

| Pictures

B videos

‘= Windows (€:)

s USB_DISK (D)

== DATA (Vignx324Q.gnk.st.com) (1)

= AMSDATA (\gnx5%48.gnbist.com) (L)
== PR1 (\ignx3349.gnb.st.com) (W)

=g p_memsdocs (\ctofsi0fs.cto.st.com) (V)
== Superisory (\agrfsOM4b.agr.st.com\prg_amsiaoclabl\Projects) (Z:)

s USB_DISK (Er)

¥ Network

Bitems  1item selected 438 MB

C\AlgoBuilderinstall

=] _uninstall.bat

& install_swdstrm32_win_32hits-v2.d.exe

A= install swdstm3Z win_Bdbits-v2.d.c

/1142018 3:50 PM

Applicatinn
Applicaticn

u o Cit x Eﬁ Ty Maw ftem = |;— [ Open ~ B sefectal
Wi Copy path * ‘U Easy access > —_— Edit i /Select none
T Maove Copy Delete Rename New Praperties )
|ﬂ to= to= - folder - 4= History E‘F Invert selectian
Clipboard Organize Mew Cpen Select
« . g + ThisPC 5 Windows (C3) » AlgoBuildernstall »
=
Naime Date modified Type
s Quick access
data 8530 PM Fife folder
- documents 2018 530 PM File folder
\__=|_|ns(:all.ba't 61472018 4:58 PM Wiriddws Batch File

Windows Batch File

Open

B9 Run as administrator

&

Troubleshoot compatibility
Pin to'Start

TZip

CRC SHA

Edit with Notepads+

Scan with Windows Defender...

&

S

Scan for Viruses...

TortoiseSVN

Winhergs
Rin to taskbar

Restore previous versions

Send to

Cut
C;npy

Create shortcut
Delste

Size

2KB
TKE
% KE

29211 K8

Search AlgoBuilderinstall P




4. Execute the install sw4stm32 win 64bits-v2.4.exe as administrator
and confirm default settings.

AlgoBuilder

Installation

& Installation of SystemWarkbench - O X

Please read the fallowing information:

Abgut Spsiem Woskbench for STMEZ

Spetem Moskbesch for STMIZ - Bare ¥etal Bdicicn iz an Belipes
integrated IIE. Tt provides 2 software development plasform for your
STMIZ bozxd. The IIE helps you to quickly sreate a O embedded project
for yeur tazges. It alss integzates code editar,
compilision {cempiles. azseabler, ligkes...) tools and
remcte-debugying Tools.

The folloving festures are incluied im Syscen Wortbensh for STMIZ -
Sare Mesal Pdirion :
- STMAZ Devices desabize and libzaries

generasor
= Bailding tpols (GCT-based cxoes compiler, assembler, Limber)
-~ Debugging teclz fOpeadCD, B/
B el s
Demmenasion

Spetem Horkbench for STMIZ is compstitle with Exlipes extended
festuzes snch 2s Subyersive.

The TIE allows you t= easily creste 3 project and compenenss for the
Sewice, To quickly build is and gemesase the EIF £ile, binary. To
debug the project, Systes Woribenck for STHIZ provides 3 debug
configuration o do the conpeceion with ST-Link/VE o debng on chip.

& Installation of SystemWaorkbench - O

Please read the following license agreement carefully:

P

Eod-Taer Licenzs Agreemest for Acf Syztem Woribesch(TH)
Foftwars Development Tosls

iR=u. Z01A-07-17)

TEIS END USES. LICINSE AGREZMENT (VLICENSEZ®) IZ X ITGAL 3GACTMINT BPTWEZY YOU {EITHER i SINGIZ
IFDIVIDUAL, OR SDWELE LESAL ENTITY 3¥D AC6 SARD (“Ac€”/ EOR TEE TEE OF TET SOFTWRRE
ECCOMEANYING TETS LICEWSE. C6 TS CNLY WILLING TO LICIWSE TEE SOFTWRSE TO YOU ON COBDITION
TEAT YOU ACCEPT ALL OF TEL TEEME IN THIS LICENSE. 5Y CLICHIVG "I MGREZ™ 0B BY INSTALLING CR
CTEESNISE USING GBL COPYISG TEL SOFTVASE YOU INDLCAIE TE YOU AGREE 10 S5 SOTSD 5T AL T
TERMZ CF TEIF LICERSE. IF YO DO WoT 2GREE TO THE TERME OF TEIS LICERES, ACE 18 DHWILLING T
LIS THE SUFTISE T0 YU 00 MO TCWNIAAD, TNTAIL, TS, CR COPY TR SOTVARE.
“Foftware™ means any. scftware, Eirmare and data accempanying this License. any documensation
supplicd with i, and any Updaces, iz all cases relaving oo the Ae€ package of =ofoware
developmens spals. The parkage includes the Symsex Hpckbench for STMIZ immegraced develepmens
enyizormens (TIE| with buwild tools, including compiles, azsssbler, linkes, libraries and
tode. For convemience, your package alss inclufes, or zllow poo to downlosd, Separsse
Eiles jdefired beloy in Clause € and also referzed 5o & "MCU Fizmware"], but these are
Licenged under thiir cwn tarme and met 1w part of the Safmware.
“Seat” meims the authorisasion from 36, as svidenced in the sales order, dzlivery
comfirmstion email and Lizense Eey iswoed to peu by Ack, o use and cun certain components o
features of the Software, énly im the quintibies and for the time periods staed Shereim, and
applicabie) only wish the barget devices, and only in the comtri=s or grographic

T actept the terms of this license agreement.

() T do not sccept the terms of this license agreement.

| Eereious

Installation of SystemWarkbench h — O

3 Please read the following llcense agreement carefully:

06 15 WILLING TO DELTVEH TO YOU THE SOPTWRRE (A3 DEFDED SEEOW), WEICE 19 LICEXSED 5T OHACIE
MCRICR. INC. POR AND ON SEEALF OF [TSELC AND IT? SUESTOIARIES WD ATPILTATES TNDZR COMMON
CTEOL ("CRSCLE™). CNLY UROE TEZ SONDITION TEAT YOU ACCEPT ALL OF TR TERMS CONTATIZD I¥

I |TEIS SINARY CODT LICENSE AGRETMENT DNCEUDING T SSSTRICTIONS AND ZXCZPTICS 32T TORTE 1N TED
SOFTRARE SEATME FILE XD TAE LICERST TERMS TEE "RGEEDMENT") 33 IF
Y0 ¥AD EROCTRCD YOWRSILT TEE SOFTWARE DTRECTLY FROM CRACLE. PLERSE AZAD THE AGREDMERT BELOR
CANEFULLY. BY STLECTING THE ACCIPT LICENSE 3CRESMEWT™ (R TEE EQUIVALEET) BUTTON AND/CH BY
TITFE TET SCETWARE TOU ACKWOWLEDGE TEAT YOU SXVE SERD THE TERME OF THIS AREEMINT AND RGAIZ
O THEEM. IF YOV 55 MCREEDNG TC TICEE TEAMI OF BEFALF OF 3 COMPANY CR LEGAL ENTITY, TUU
SETRESENT THAT TOU MAVE TEG LLGAL MUTHORITE TO EDND THE LEGAL ENTITY TO TEESE TERMS. IF YO0
00 NOT EAVE SUCH IUTEGALTY, O IF ¥OU DO ¥OT WISE 10 55 BOUND BT THE TERME CF THLI GIEDMENT,
TEEN SELECT TAG "DECLINE LICENSE 3GREEMENT” (R THE EQUIVALENT) EGTTON AND TOU MIST WOT 52
THE SOFTIRIZ O¥ ANT MEDIX OF WELCH TAD SOFTWMAE IS CONTAINED AND YOU MUST PRCMTLY BZTURS TRE
T soFTRE TO

DrSCIATER GF RASRANTY. THE SOETRME 15 FRGVITED -iS 15° WITHOUT SAGANTY OF ANY ATRD, 3cE
TISCLAIM ALL FARRAFTIES, SKPAESS OR TMPELIED, INCLUDING WITEOUT LTMITATION, ANY IMPLEED
RFAANTIES G MERCRAWTARILITY, FITHESS FOR 3 EARTICULAR EURPOSE OB BONTNPRINGEMEXT
LIMITATION CF LIASTLTTY. [ WO EVENT SEALL ACE 5= LTARLZ 703 ANY TNDIIECT, INCIIENTAL,
SIECIAL, FUNITIVE (R CONSEQUENTIEL DMMASER, 0R TUMAZES FOR LOSS GF BROFITS, REVERTE, DATE or
AT T, mmn!mmmmvm!.mmuhmmmﬂmmm =vEs
IF 3CS KRS BEEX ADVISED OF TRL BCSSIBILITY GF SUCK DEMAGES. 376
AMAGES EERTUNIER SFALL DF 0 EVENT EXCEED GRS THOUSAND DOLIARS (V.. 51,000).

|@rmmemafmmagm;|
() [ do not accept the terms of this license agresment,

" @_..
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AlgoBuilder

Installation

& Installation of SystemWarkbench - ] X & Installation of SystemWorkbench — u] X & Installation of SystemWorkbench — u] X
 Select the packs you want fo install =] Setup Shortcuts
() Note: Grayed packs are required, .
Syatem Workhench for STM32 5 [ Create shorteuts in the Start-Men
&) ST-Link/¥2 driver {requred for proper apsration) 6.03MB, [ Ereate additisnal shorteuts on the desktap
[  STunkServer 723,768 )
Select a Program Group for the Shortauts:
e shorct o
72 | Oarrent user
System :Q“"’Mw (@) all usere
‘ " o i
Workbench | [ Sekct e nstalation path: = \Administrative Tocls
T Ccs\Systemorkbench| ” S wonse... [t
\Altum Designer 6
S— Autonomy’
e o
System Warkbenth for STHIZ idaxygen
st v
|Systemborkbench | ] Default |
Total space Required: 43358 M8
Avallable space: 112.55G8
| demems |[Brec || @an | | @oman

life.augmented



AlgoBuilder

Installation

& Installation of SystemWarkbench - a b e

Installation wil proceed with the following settings: Press Mext ko conkinug,
Installation Path
C:Ac6\SystemWorkbench?
Chosen Installation Packs
System Workbench for STM32
ST-Lmk/V2 driver (requirsd for proper operation)
STLinkServer

Lys
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AlgoBuilder

5. Execute SW4STM32, set the Workspace directory to the default options,  Installation
then close the application.

606

tools

pased on : / .~~~
& Warkspace Launcher ¥

Select a workspace

Eclipse stores-your projectsin a folder called a workspace;
Choose a workspace folder to use for this session.

Workspace: |\ “| | - Browse...

J Use this as the default and do not ask again

m ok || canced |

life.augmented




6. Check that following applications were installed on your PC:

v AlgoBuilder v2.0.0

v Unicleo-GUI v1.5.0

v' STM32 ST-LINK Utility

v' System Workbench for STM32 (AC6)

AlgoBuilder

Installation



AlgoBuilder GUI walkthrough

life. ’I
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AlgoBuilder

[ Algo Builder GU| - MyExample1xml - O o
Fle Edit \iew Frmware Took Help M e n u & To o I ba r
LB AR A aaad s BRX T TL sl G~ B

o (= 5

; C: ”m;;:rnén \[.ferslun: l|.-BH =l

» Display Sensor Hub provides links to sensor and algorithms in arder

E:;?:J[F)spgmps ta retrieve dats from them.

Work win  Block

> orkspace i

+ MaotionGC

> Mann P rpetie — Description

» :ﬁcn:\i gsnﬁnesh‘le :?}Esars and algorithm's data rate in Hz.

» on =l

» Other A,cceiagreur:etar FLHT' Saale (inth

> Sepsar Hub enéor Hub] 3;&:21& a::célgmmf;er full scale.

EEL:nt{aJLnglc Gyroscope Full S&gale (gmt} i

, Defines the gyroscope ful scale.

' \Uf:cfmﬁ;mou:mmns Values: 245 dps, 500 dps, 1000 dps, 2000 dps

Propertes 5%
= Name Value Type
L | b ra I‘y Data Rate 100 Wt
Accelerometer Ful . |4 g ~ | ENUM
Gyroscope Full Scale | 500 dps ~ | ENUM
Console ax
Block
(Errors, Warnings, Other information)

X:Zﬁqg' y: B9 zoom; 1




Display:

Several options can be used to display output data.

Properties

Name

Number of Curves
Graph Name
Waveform 1 Name
Waveform 2 Name
Waveform 3 Name
Waveform 4 Name
Waveform 5 Name
Waveform 6 Name
Unit Name

Properties

Name

Number of Values
Value 1 Name
Value 2 Name
Value 3 Name
Value 4 Name
Value 5 Name
Value 6 Name
Value 7 Name
Value 8 Name
Unit 1 Name
Unit 2 Name
Unit 3 Name
Unit 4 Name
Unit 5 Name
Unit & Name
Unit 7 Name
Unit 8 Name

Lys

augmented

Value

4

Arbitrary Float ...
Float 1

Float 2

Float 3

Float 4

Value
4

Float 1
Float 2
Float 3
Float 4

Unit 1
Unit 2
Unit 3
Unit 4

(=4

Type
INT
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING

& X

Type
INT
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING

- il Custom Fields Plot

Graph 1

Graph 2

Value
(Float)

1 Unit 1 Foat 1
2 Unit 2 Feat 2
3 Unit 3 Foat 3
4 Unit 4 Foat 4

1.100000 Unit 1
2.200000 Unit 2
3.300000 Unit 3
4.400000 Unit 4

Logic

Analyzer

Value
(Int)

Properties & X
Name Value Type
Number of Channels 4 INT
Channel 1 Name Swl STRING
Channel 2 Name Sw 2 STRING
Channel 3 Name Sw 3 STRING
Channel 4 Name Sw 4 STRING
Channel 5 Name STRING
Channel 6 Name STRING
Channel 7 Name STRING
Channel 8 Name STRING
Properties g x
Name Value Type
| ‘Number of Values 4 INT
Value 1Name Int1 STRING
Value 2 Name Int2 STRING
Value 3 Name Int3 STRING
Value 4 Name Int4 STRING
Value 5 Name STRING
Value & Name STRING
Value 7 Name STRING
Value 8 Name STRING
Unitl Mame Uikl STRING
Unit-2 Name Unit-2 STRING
Unit 3 Name Unit 3 STRING
Unit< Name Unit STRING
Unit 5 Name STRING
Unit & Name STRING
Unit 7 Name STRING
Unit 8 Name STRING




Graph - Displays data as a time graph

Graph :
2 Acceleration O *

Properties B X
Name Value Tvpe

MNumber of Curves 6 INT

Graph Name Graph STRING

Waveform 1 Mame Waveform 1 STRING

Waveform 2 Name Waveform 2 STRING

Waveform 3 Mame Waveform 3 STRING

Waveform 4 Mame Waveform 4 STRING

Waveform 5 Mame Waveform 5 STRING

Waveform 6 Mame Waveform 6 STRING

Unit Marme STRING

Zero axis position Middle ~ | ENUM

Auto-scale OFF ~ | ENUM

Full Scale 1 STRING

Lys
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Logic Analyzer - Displays logic signals which can have values only 0 or 1

Logic
> Anabyzer
Properties
Name Value
Number of Channels 8
Logic Analyzer Name Logic## Analyzer
Channel 1 Name Ch1
Channel 2 Mame Ch2
Channel 2 Mame Ch3
Channel 4 Name Ch4
Channel 5 Mame Ch 5
Channel & Name Cha
Channel 7 Mame Ch7
Channel 8 Mame Che

B X

Type
INT
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING

n 1.8
| e




Bar Graph - Displays actual value as bar

Properties

Name
Mumber of Bars
BarGraph Mame
Bar 1 Mame
Bar 2 Mame
Bar 3 Mame
Bar 4 Mame
Bar 5 Mame
Bar 6 Mame
Unit Mame
Fero axis position
Auto-scale
Full Scale

Lys
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BarGraph

Value

6
BarGraph
Bar 1
Bar 2
Bar 3
Bar 4
Bar 5
Bar 6

Middle

OFF

1

B X

Type
INT
STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
EMUM

EMUM
STRING

jg Acceleration




Histogram - Displays values distribution

| Histogram illi, Histogram - -

Properties g X
MName Value Type
Histogram Mame Histogram STRING
Unit Name STRING
MNumber of Intervals 10 INT
Zero axis position Middle ~ | EMUM
Auto-scale OFF ~ | EMUM
Full Scale 1 STRING

rt: 0.1 Interval End: 0.2 Count: 350

Lys
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Scatter - Displays X,Y,Z data in 2D X-Y, X-Z, Y-Z chart

+* Magnetic Field O *
| Scatter
-omG -e0mG -50mG  -H0mG |-30 -20mis -_1E| ma |06 +10mG | +20mG +307
. +30'mG
Properties g X o s
+20mG
MName Value Type
Size of Input 3 INT +i0me
Scatter Mame Scatter STRING
Value 1 Mame Value 1 STRING
Value 2 Mame Value 2 STRING _ . o
Value 3 Name Value 3 STRING LA g W ity e
Unit Mame STRING g | i
Auto-scale OFF ~ | ENUM L
Full Scale 1 STRING 78N
'?‘d me

40 mS

-50 mG

-60 miz

Lys
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3D Plot - Displays X,Y,Z data in 3D chart

|  Plotap .

Properties g X
Name Value Type

Plot Name 3D Plot STRING

Value 1 Name Value 1 STRING

Value 2 Name Value 2 STRING

Value 3 Name Value 3 STRING

Unit Name STRING

Auto-scale 0OFF « | EMUM

Full Scale 1 STRING

Autoscale is OFF Clear Points

71
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AlgoBuilder

Fusion - Displays quaternion data as teapot 3D model.

P Fusion & sersorfu o
Properties F X
MName Value Type
Window Name Sensor##Fusion STRING

Model Name [Teapot  ~|ENUM

[ Reset model

Lys
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Value - Displays the exact float or integer value

Value
Properties =4
MName Value Type

MNumber of Values 8 INT

Window MName Values STRING
Value 1 Mame Value 1 STRING
Value 2 Mame Value 2 STRING
Value 3 Name Value 3 STRING
Value 4 Mame Value 4 STRING
Value 5 Mame Value 5 STRING
Value 6 Mame Value 6 STRING
Value 7 Name Value 7 STRING
Value 8 Mame Value 8 STRING
Unit 1 Name Unit 1 STRING
Unit 2 Name Unit 2 STRING
Unit 3 Name Unit 3 STRING
Unit 4 Name Unit 4 STRING
Unit 3 Name Unit 5 STRING
Unit & Name Unit & STRING
Unit 7 Name Unit 7 STRING
Unit 8 Name Unit 8 STRING

0.007000 [g]

0.000000 [g]

1.020000 [qg]




User Input: AlgOBUIlder

Three types of data can be sent from Unicleo-GUI to running firmware: Binary, Integer and Float.
Input blocks can be used in the design to allow user interaction with the running firmware.

Input Value Input Value Input Value

Properties g x Properties 8 x Properties 8 x
MName Value Type Mame Value Type Name Value Type
Window Name Integer Values  STRING Window Name Float Values STRING Window Name Binary Values STRING
Mumber of Values 4 INT Number of Values 4 INT Mumber of Values 4 INT
Default Value 1 ] INT Default Value 1 ] FLOAT Default Value 1 0 INT
Default Value 2 0 INT Default Value 2 ] FLOAT Default Value 2 0 INT
Default Value 3 0 INT Default Value 3 ] FLOAT Default Value 3 0 INT
Default Value 4 0 INT Default Value 4 ] FLOAT Default Value 4 ] INT
Value 1 Name Value 1 STRING Value 1 Name Value 1 STRING Value 1 Name Value 1 STRING
Value 2 Name Value 2 STRING Value 2 Name Value 2 STRING Value 2 Name Value 2 STRING
Value 3 Name Value 3 STRING Value 3 Name Value 3 STRING Value 3 Name Value 3 STRING
Value 4 Name Value 4 STRING Value 4 Name Value 4 STRING Value 4 Name Value 4 STRING
[=] Integer Values * |=] Float Values * ] Binary Values X
Value 1 o | Value 1 o | Value 1
Value 2 o | Value 2 o |
Value 2
Value 3 o | Value 3 o |
Value 4 o | value 4 [ | Value 3
‘ ” Value 4

fe.augmented



User Input: AlgOBUIlder

Input blocks can be used in the design to allow user interaction with the running firmware.

Input Value
(Int}
{Bnal"‘,'} S pat  [COM3 :l S Opert ¥ Disconnect | v Start Siop - Settings | A Exit Properties 4
[fo. [ FW Manegement | User Messages | GEWERIC Opbons: | Name Value Type
Properties 2 X Sig Number of Values 4 INT
Name Value Type 1 Custom Bit Values Custom Int32 Values Default Value 1 1 INT
Number of Values 4 INT ?hm - Walue 1 1 Default Value 2 2 INT
Default Value 1 1 INT Jds: i Default Value 3 3 INT
Default Value 2 0 INT | switch 2 | Nale2 2 Default Value 4 4 INT
Default Value 3 0 INT I Value 1 Name Value 1 STRING
Default Value 4 1 INT | Switch 3 Wvalue 3 3 Value 2 Name Value 2 STRING
Value 1 Name Switch 1 STRING — Value 3 Name IValue 3 STRING
Value 2 Name Switch 2 STRING [owechia | Meley ¥ Value 4 Name Walue 4 STRING
Value 3 Name Switch 3 STRING U H I G U I
Value 4 Name Switch 4 STRING nicieo-
Custom Float Values nput Value F
Fvalue 1 11 (Float)
Falue 2 2.2 Froperties X
I Pikia S Name Value Type
Number of Values 4 INT
rvalies 44 ‘Default Value 1 [ FLOAT
Default Value 2 22 FLOAT
Default Value 3 3.3 FLOAT
STMicraslectronics Unicea Yersion: 1.3.6.4353 Firmware Version = 4.0.0 Expansion Board: TR0 142 Default Value'd 4.4 FLOAT
Value 1 Name Fyalue 1 STRING:
Value 2 Name Fvalue 2. STRING
Value 3 Name Fvalue 3 STRING
Value 4 Name FValue 4 STRING

Lys
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AlgoBuilder

New Features v1.5-v2.0
FFT analysis, FFT plot, Window, Peak detection in frequency spectrum
Real ODR measurement for accurate FFT analysis

New example for FFT analysis

X axis
- o T ) | FFT Plat |
Acceleration |, Demuy (3] A
| [Sensor Hub) P hI fol & Firs E |_K
N\ s '

": g [ feles =

>

&

B (Float)
| Z axis
Properties g x ..»I i | /
MName Value Type ; e
Data length 1024 ~ | ENUM
Window Type Mone ~ | ENUM
€ FFT X asis ] X

Data length: 32, 64, 128, 256, 512, 1024
Window: Hanning, Hamming, Flat Top

Output Data Rate: Magnitude: 2g

"I FFT Samples: 4 Display Mode: Bars -

fe.augmented




AlgoBuilder

New Features v1.5-v2.0
Multi level design

Possibility encapsulate part of the design into one function block,
which can be saved into a library to be reused many times

Main design
Subdesign 1
Subdesign 2
Subdesign 1 ; - —
Subdesign 2 h%ﬁgm e P o

180 344159 |/
Subdesign 3 (Float) E

Lys
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AlgoBuilder

New Features v1.5 - v2.0
Loops (for, while)

For Loop - is subdesign intended for loop, which is used if number

of iteration is known before entering the loop
While Loop - is subdesign intended for loop, which is executed until

a defined condition is valid

Subdesigns /X
Filter: X

IForLoopTemplate
1SubdesignTemplate
'WhileLoop Template
FirstSubdesign
IntensityClasification
RadToDeq

SumBuffer | = :
Varance Cycle F »| Oyce
Count Count
| o F Break
(Int) ™ conditior

Lys
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Design Rules: AlgOBUIlder

Several rules must be kept during project design to create project which could be validated and compiled.
» Connection can be made between input and output of different function blocks
« |tis impossible to connect two inputs or two outputs together

« Only input and output of the same type can be connected, exception is variant input which will get the type of
connected output

« Only input and output of the same size can be connected together. Some inputs and outputs can have
variable size. Size value can be changed inside properties window. The size of input or output can be seen in
the description window when the block is selected.

« For clarity the thickness of the connection line indicates the size of input and output and color of the
connection line indicated the type (default: green — float, blue — integer, violet — other).

« All inputs must be connected

Function Blocks

[Sensor Hub] F—. Acce[lzr:;ation F—. Graph 1
\7K Connections)( /
57 Input - Output Input - Output

fe.augmented
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[E Algo Builder GUI* — O ®
Fle Edit Wiew Frmware Took Help

| ek D o Q@ o BEX I ATL oo HME Gherns ~| kg E
4§ Onen Design Crl+8  |f Descrigtion. 8 X
= save Design Ctrl+S [ '
[% save Design As . N . . .
Sl sl 1. Select Application Settings in File menu.
. Wetwork Update Settings
e £l Application Settings X
e Uniclea-GUT Path
ﬂz‘;ggr‘; |C/Program Files (x85)/5 TMicroelectranics/Unicdeo-GUT Unicleo-GUL exe || Browse |
» Other Systemn Warkbench for STM32 Path
» Sepsar Hub § e
> SEuI;rHtBlLDgIc |C:iAcE{SystemWnrkbanchjedlnsec.exe || Browsa |
» Sign !
+ User Input IAR Embedded Workbench Path
» Neckor Operstions | || a0 |
L=raowE
Keil uVision Path
| || Browse |

Fittar Bulld Output

Font Sze: g [ | oK || Cancel | Properties 8 X

Name Value Type

2. Enter the path to Unicleo-GUI
C:/Program Files (x86)/STMicroelectronics/Unicleo-GUIl/Unicleo-GUl.exe

3. Enter the path to selected IDE
s C:/Ac6/SystemWorkbench/eclipsec.exe 8 x

4. Click OK

” x:-136 y: 26 zoom: 1

life.augmented




Algo Builder GUI* - O K
g

Took  Help

W BB S ecaa se BAXETL 525006 @ FEwE @

iy 8 x

> Comparison N

» Constants H H
e Click on New Design
» Graphics

» Logic Operators
» Math Operations
> MotionAW

> MotionFX

» MotionGC

» MationID

> MotionMC

> MotionPW

» Other

» Sepsar Hub

> Seguential Logic
» Signal

> User Input

» Neckor Operstions

Properties & x

Name Value Type

Console g x

" x:-119 y: 134 zoom: 1

life.augmented




Algo Builder GUI* - O K
g

Fle Edm view TGS Tools  Helr
: n : = |

KOS @@}' CECHONT NI W B E X | | —‘#CO-' “@_r.rgqun_d "'H-EI
iy 22 Description ERS
» Comparison
» Constants
» Display
» Graphics
+ Logic Operators
» Math Operations
> MotionAW
» MotionFX
» MotionGC

» MotionID £l Firmware Settings
» MotionMC

X
" Motinp 1. Browse for C:\AlgoBuilder\MyExample_1|directory

> Other Firmware Location
+ Sensor Hub -

» Sequential Logic |C:;‘AIgoBmIder{MyE)mmpIe_l || Browse |
» Signal .
» User Input Toolchain / IDE

e swasTHE2 -| 2. Select compiler SW4STM32

Target

NUCLEO-L476RG -] | ok | cancel |

3. Select Target NUCLEO-L476RG 4. Click OK properces 5 x

Name Value Type

Console g x

" x:-119 y: 134 zoom: 1
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[ Algo Builder GUI - *

Fle EdE Wiew Firmware

Took  Help

HAR A Qg s BRXIFSITL Sk

5

» Comparison
» Constants
~ Display
Graph 1
Graph 2
Logic Analyzer
Value (Float)
Value (Int}
> Graphics
» Logic Operators
+ Math Operstions
» MotionAW
» MotionFX
» MotionGC
» MetionID
» MotionMC
» MotionPW
» Othier
v Sensof Hub
[Sensor Hub]
Accaleration [g]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]
Sequential Logic
Signal
User Input
Vector Operations

RV

s
Expand Display and Sensor Hub libraries

Console

Properties 8 x
Name Value Type

" % 59 y:-95 zoom: 1
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[ Algo Builder GUI - *

Fie

BEAB S aaaa e BEX I TL 2%

G orone - ) E

5

» Comparison
» Constants

Display
BREpR
Graph 2
Legic Analyzer
Value (Float)
Value (Int}

> Graphics

» Logic Operators
+ Math Operstions
» MotionAW

» MotionFX

» MotionGC

» MetionID

» MotionMC

» MotionPW

RV

Other

Sensar Hub
[Sanear Hub]
Accaleration [g]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]

Sequential Logic

Signal

User Input

Vector Operations

2 S S TS

Drag and drop [Sensor Hub], Acceleration and
Graph 1 function blocks to the workspace.

Properties

Console

Name

Value

Type

x:-354 y:-301 zoom: 1
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EE] AlgaBuilder GUI* - O 4
Edt view Frmwerz Toos He
BAB A aaaaloe BRX I At TL~ bl 8o H el @
Lbzary. B x| Description Bx
Fitar: | [ Graph el
+ Comparison Version: 2.00 . )
. Copstants Graph. Displays up to sox realtime curves. The X-axis
v Display represents time, Y-axs is value,
Ear_ Input Pins:
Fusion in {varant x 3}
Graph Input data to plot (y-axis value). The input data sze
Histogram has Eo match with number of cunees.
Leagic Analzer .
plat3D Properties: )
Seatter Nurrber of Curves (inth:
valia Defines number of curves to plot. Value must be from
Lto 6.
s 1. Selects Graph SR 6
+ Math Operations Label of the graph.
» MotionAW ngefon‘r;é_lName (ﬁtﬁngi: -
» MotionFX ame of the waveform 1.
. Mztizzﬁc Waveform 2 Hame (string):
. Name of the waveform 2.
* MotionID Waveform 3 Name (string):
* MationMC Hame of the wavaform 3.
» MotionPW \Waveform 4 Name (string):
» Other Name of the wavefarm 4.

~ Sensor Hub
[Sensor Hub]

Acceleration [g]
Angular Rate [dps]
Hurmidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]

Sequential Logic

Signal

Temperature

User Input

Vector Operations

VW W W W

2. Set properties

Console

Waveform 5 Mame (string): -
" £ =

Properties & x

Name Value Type
Mumber of Curves 3 INT
Graph Mame Acceleration STRING
Waveform 1 Name X axis STRING
Waveform 2 Name ¥ axis STRING
Waveform 3 Name Z axis STRING
Unit Mame [a] STRING

Zero axis position Middle ~ | ENUM
Auto-scale ENUM

Full Scale 1 STRING

: 260 y: -292 zoom: 1
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[ Algo Builder GUI - * — O ®
Fle Edt View Firmware Took Help

L == L - ——————— |

AR & aaae o BEXl [T 2 co il 8o~ k| =

Lbrary 5% Desaription S

» Comparison

» Constants

~ Display
Hizph
Graph 2
Logic Analyzer
Value (Float)
Value (Int}

> Graphics

» Logic Operators

+ Math Operstions

» MotionAW

» MotionFX

» MotionGC

» MetionID

» MotionMC

» MotionPW

» Othier

v Sensor Hub
[Sanear Hub]

Accaleation [q) Connect function blocks.

Angular Rate [dps]

Nagnat Pt T (Click on output and hold left mouse button,

Pressure [hPa]

__ Tempertre [ move to the input and release) Properaes 5 x
>

s SE‘:;‘T“E oae Name Value Type

> User Input

> Veckor Operations

Console 8 X

" x: 474 y: 68 zoom: 1
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- o «
Fimnwars Took  Help
LA Qe e BRX I SITL aie fil @ mem - &
B x & x
> Comparison - . ] ']
caens— Save the design to default path with name “MyExample_1.xml
' D'ﬁp.la'lf —_—
Bizph L
Graph 2
\L{zﬁjzﬁé’;:ﬁ’ 8] Save Design x
Gmﬁ;&‘ (Int) 4 | > Miroslay BATEK » STMicroelectronics » AlgoBuilder » Designs v & | SearchDesigns £
‘ ;na%“c gg::_;zr:s Organize Mew folder -
X
4 Mo‘t!anW . (& Mame Bate madified Type Size
* MetionFX # Quick access
* MotionGC I et = [ Exampled_Demoam! XML File
» (a2
‘ :ﬁggﬂ’c e | Exampleda. FrezFallxml GIEHOBAM XML File
:‘ MationPW ‘!’ b oadsi o Ig Examplef3_Tilt_Measurement.xml 2018 208 AM XML File
» Other 5| Documents e Example04_Fittersuml AM  XMLFit
™ Sensor Hub o Pictures (BBl Fxasmoptetls Ermtine. Compritationarsl HIBREAM  AMLFile
Acceleration [g] AlgoBuilder [’ Bxamples ZeroCrossing: PeakDetectorx.. 6/4/20189:08AM XML File
Angular Rate [dps] Designs IQf Examplel7_Algorithms_Integrationm| /42018 %08 AM XML File
Humidity [percent] L ' Example08 60 Detection xm GAIDIBTOEANM  XMLEile
Magnee.Feid [uT] S Aars 5&3 pu}aiﬁ[:inge a2l I 'Jwa ]:3 PM XML F:I
Prassure [hﬁa] ] WEd(?yEﬂ_‘\B impled8_60_I .Ectmn_v il - 20 .:_ v XN e
Tamparature [°C] & Exampleld_Tilt_Using_Gyroaml 2018 BT AM XKML File g %
z :'Eifnm] Logic I This PC || MyEsample_Taml BOZ0IE125TAM  XMLFiE N ] — Ty N
S fisor Tt 9 Deskiop gwsxampte_zm\ /072018 1:02AM XML File 2 KB
i Vector Opertions B dicimesis & MyExample 3xmi 018 1H13AM  EMLFle 2EKE
fe_4xrnl S127AM XMLk 16KE
3 Downloats e MyExample_dml X e &
B Music
|1 Pictures v
File rame: | MyExample_1axml ~ |
— Save s type: | Mol ~| B
e
~ Hide Folders Save | Cencel
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Fie

[E Algo Builder GUI - MyExample:1xml

BEEB A eaqa s mEXxlEaATLE $wle

G orone - ) E

5%

» Comparison
» Constants
~ Display
Hizph
Graph 2
Logic Analyzer
Value (Float)
Value (Int}
> Graphics
» Logic Operators
+ Math Operstions
» MotionAW
» MotionFX
» MotionGC
» MetionID
» MotionMC
» MotionPW
» Othier
v Sensor Hub
[Sanear Hub]
Accaleration [g]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]
Sequential Logic
Signal
User Input
Vector Operations

RV

1. Click on Generate C code

Properties

L L

Code generation finished successfully.

)

. Check if the code was generated successfully

Name

Value

Type

" x: 465 y: -269 zoom: 1
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Algeo Builder GU| - MyExample_ 1 xml — O k4
9 Iy P

=3 @@}'@)\QG\Q ﬁCﬁEX:I I_— st o} ¢ “i_{d}:{:f{}un_& !IH@ _

» Comparison

> Sty 1. Click on Show C code
Graoh 2
Logic Analyzer
Value (Float)
Value (Int}

> Graphics

* Logic Operatars Ealgo_builder.c-l\lotepad H H - o X

 Math Operatons. | _ 2. See the generated algo_builder.c file

> MotionAW File Edit Format View Help -

» MotionFX

. MationGC |#:'an1ude "algo_builder.h”

» MetionID

» MotionMC id * .
. void *Nodel;

Other float Node2[3];
Senfsquub

£

Sas ol
Accaleration [g]
Angular Rate [dps)
Humidity [percent] yoid AB_Init(wvoid)
Magnetic Field [uT]| -

Pressure [hPa] {

Temperature [°C] Sensor_Hub_Init(1€@, 1, 1); a x
S tial Logi .
S;‘:” ial Logic Graphl_Set(3); Tyoe

User Input Graphl_Set Names("Acceleration”, "X axis", "Y axsi", "Z axis", "Waveform 4", "Waveform 5", "Waveform 6", "[g]");

Vector Operations }

RV

void AB_Handler(wvoid)

{
Sensor_Hub_Handler(&Nodel);
Accelero_Sensor_GetData(MNodel, Node2);
Graphl_Update(Node2);

¥

" x: 340 y:-294 zoom: 1
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[E Algo Builder GUI - MyExample:1xml

BER Facaaoc B@XlETLE 59 %

¢ Qreera— - JHES

Library

5%

» Comparison
» Constants

Display
skl
Graph 2
Logic Analyzer
Value (Float)
Value (Int}
Graphics

» Logic Operators
+ Math Operstions

MotionAW

» MotionFX
» MotionGC

MotionID

» MaotionMC
» MotionPW

£

RV

Other

Sensar Hub
[Ssneat HUb]
Accaleration [g]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]

Sequential Logic

Signal

User Input

Vector Operations

1. Click on Build Firmware

2. Wait for compilation
3. Check that the code was compiled without error

Properties

Lonsale

Generating binary:

arm-none-eabi-objcopy -0 binary "STM32L4xc-Nucleo-Project.eff” "STM32L4xx-Nudeo-Project.bin” & arm-none-eabi-size -—-format=berkeley STM32L4x¢-Nuclea-Project.elf
text data bss dec hex filename

169984 7672 46628 224284 36clc STM32L4xx-Nucleo-Project.elff

19:34:17 Build Finished (took 7m:23s.656ms)
Invoking scanner config builder on project
Build Process Finished

Exit Code: 0

Name

Value

Type

" x: 60 y: -282 zoom: 1
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Algeo Builder GU| - MyExample_ 1 xml — O k4
9 Iy P

E @@)’_@l@:@. Sc BEX | 1T e ce I E] 8 proewes -| bl |

Lbrary 5% Desaription S

> Comparison

» Constants =

v Denly 1. Connect STM32 Nucleo to your PC 4. Open Unicleo-GUI
skl
Graph 2 -
Lo A 2. Click on Program STM32 Nucleo
Value (Int}

> Graphics

» Logic Operators

+ Math Operstions

» MotionAW

» MotionFX

» MotionGC

» MetionID

» MotionMC

» MotionPW

» Other

v Sensor Hub
[Saneat Hub]
Accaleration [g]
Angular Rate [dps]
Humidity [percent]
Magnetic Field [uT]
Pressure [hPa]
Temperature [°C]

Properties & x
> Sequential Logic
> Signal Name Value Type
> User Input
> Veckor Operations

Console g x
text data bss dec hex filename
169984 7672 46628 224284 36clc STM32L4xx-Mucleo-Project. eff

19:34:17 Buld Finished (took 7m:23s.656ms)
Invoking scanner config builder on project
Buid Process Finished

FWV binary file programed successfuliy!

IDE: 5W45TM32 Target: STM32L476RG Drive: D: NODE_L476RG 3- Wait tiII the board is prog ram med -

” x: 260 y: -277 zoom: 1
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1. Check the boards is connected to Unicleo GUI

k& Unicleo-GUI = %
Sei=t Dmnce ILr:ms D ¢ Comnect Disconnect | | Start Stop | ) Settings | L Exit
. Info FY Management Us:Messages THS01A2 Options
,;EW 2. Click Start to run the application
2 .
3. Open data visualization
STMicroslectronics Uniclen Version: 1.4.5.6408 Firmware Version = 5.0.0 Expansion Board: IKSD1A2

Lys

fe.augmented



1. Test the functionality.

k3 Unicleo-GUI

|C{'.rl\'lﬁ D Conn

Info FW Management Uiser Messages TES01AZ Ophions

‘," Ciecannect

|EJ Time Stampifcocelerstica [[gl] |
Datslog I anis

12-23:12. o
5 1 12 a

Arreleration bt Sz1E a
1 b feck 2 a
12-2%3:12. o
12:28:12. a -0.013000) 1.0z4000|
12:23:12 o ~0.013000] 1.pz4009|
12:25: o ~0.014000] 1.023000]
12:23:1z. o -g.01 1.p23000|
12:28:12. a -0.01306040| 1.0zz000|
1Z:28:42 o ~0._013000] 1.pz1000|
1285212, o 1.021000]
122512 o.a 1023000
12:38:49 a4 1.0zz000|
1Zizgzas o_goaoog| 1.p17000|
12:85: 0.00 1.0335008]
1289 o_og 1.023040|
12:38: a_6g -4.013000] 1. 018000
1229 0.0 ~0.013000| 1_pisoog|
1289 0.0
1 o
1 a -a0.014000) 1018000
1 o -0.013000| 1_pzE009|
1 o
1 o
1 5 <— Autoscale
1 o ~0.013000|
1 o ~0.013000]
1 o ~0_012000]

STMicroslectronics Unicles ¥ergion:  14.5.6405 Firmware Vefsion = 5.0.0 Expansion Board: [IKSD1AF

Y/ 2. Close Unicleo-GUI when you finished the testing.

augmented



Demo 2 - - = 5 =
Impact Detection N J—
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Impact Detection ... Evaluate if magnitude of acceleration is above given

threshold for certain time.

Acceleration
Magnitude
[a]

Impact
Threshold

.augmented



Algo Builder GUI* - O K
g

Took  Help

W BB S ecaa se BAXETL 525006 @ FEwE @

iy 8 x

> Comparison N

» Constants H H
e Click on New Design
» Graphics

» Logic Operators
» Math Operations
> MotionAW

> MotionFX

» MotionGC

» MationID

> MotionMC

> MotionPW

» Other

» Sepsar Hub

> Seguential Logic
» Signal

> User Input

» Neckor Operstions

Properties & x

Name Value Type

Console g x

" x:-119 y: 134 zoom: 1
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[ Algo Builder GUI*

BEAB S Qa8 S BRXE ITL s N @ Ew W G

Library &% Description & x
» Comparison

» Constants

» Display

» Graphics

+ Logic Operators
» Math Operations
» MotionAW

- MotionFX
ﬂ:g::%z E] Firmware Settings [:? >4
. Mot rovareloaton 1. Browse for C:\AlgoBuilder\MyExample_2 directory
> Sense;rHuh |E:MlgoBquer}MyE)anJa_2 || ‘Browse: |
» Seguential Logic 5
» Signal Toolchain [ TDE
» User Input

> Vector Operasors SWasTM32 ~| 2. Select compiler SW4STM32

Target

| NUCLED-L476RG ~| | ek || cancal |

3. Select Target NUCLEO-L476RG 4. Click OK

Properties 8 x

Name Value Type

Console g %

" x:-119 y: 134 zoom: 1
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R

[5e
Acceleration [g]
Angular Rete [dps]
Humidity [percant]
Magnetic Feld [uT]
Pressure [hPa]
Temparature [°C]

Sequential Logic

Signal

User Input

Vector Operations

i

2. Change Accelerometer Full Scale to 89 —

[ Algo Builder GUI - * — O ®
Fle Edt view FEmmware Tooks  Hel
L . — — |
AR aaae o Xl [T 2 co il 8o~ k| =

Lbrary _ 8x Dscription. 8 x
» Comparison [Sensor HI.I]J]

+ Constants Version: 1.0

> Display Sensor Hub provides links to sensor and algorthms in order
» Graphics to retrieve data from them,

+ Logic Operators

> Math Operations oﬁt?ufdpﬁlls):

) i out (void x 1):

> ﬂgg;g?xw Sensor Hub handler,

» MotionGC Properties:

¥ MotionID Data Rate (int):

» MotionMC Defines the sensor's and algorthm's data rate in Hz.

» MotionPW Range: <1, 400>

» Other Accelerometer Full Sczle (int):

v Sensariuh 1. Place [Sensor Hub] to workspace Dsfnes the accalerameter ul scle.

Values: 2 g, 40,80, 160
Gyroscope Full Scale (intl:
Defines the gyroscope full scale.
Values: 245 dps, 500 dps, 1000 dps, 2000 dps

Console

Properties 8 x
Name Value Type
Data Rate 100 INT

P Accelerometer Ful.. ENUM
Gyroscope Full Scale | 500 dps ~ | ENUM

> /4

x: 481 y:-302 zoom: 1
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Console

£ Alge Builder U - * - P
Fle Edt View Firmware Took Help
. b1 I - ——————— |

BEB A aaa@ o BRX I ATL e il Ghaee - =
LUbrary 8% Desaription 8 x
> Compatison Acceleration [g]
» Constants Yersion: 1.0
» Display Retrigve the accelerometer data.
» Graphics
» Logic Operators Input Pins:
» Math Operations SensorHubHandle (void x 1):
» MotionAW ‘Connect to Sensor Hub output.
» MotionFX

- Output Pins:
* MotionGC dats (float x 3): o
+ MotionID Accelerometer data (acceleration) in g unit.
» MotionMC
> MotionPW
» other - .
v Seerin Add Acceleration [g] function block

[Sancar Hub]

Acceleration [g]

Angular Rate [dps] I ¢ Hub] Acceleration

Humidity [percant] L el gl

Magnetic Feld [uT]

Pressure [hPa]

Temparature [°C]
> Sequential Logic
> Signal
> User Input
» Vector Operations

Properties 8 x
Name Value Type

" x: 60 y:-292 zoom: 1

=.augmented




] AlgoBuilder GUI - * - =] X
R A e e BRX I T TL+~ gceo il 85
Lbzary. B x| Description Bx
Fiter: | | Graph E=
» Comparison Version: 2.0° . )
» Constants Graph. Displays up to sox realtime curves. The X-axis
v Display represants tma, Y-axs i value,
Bar n|
: put Pins:
Fusion in {varant x 3}
Graph Input data to plot (y-axis value). The input data sze
Histogram has to match: with number of curves.
Logic Analyzer
Lok Kech 1. Add Graph function block Proparties
Settar Nurrber of Curves (inth:
valia Defines number of curves to plot. Value must be from
Lto 6.
» Graphics Range: <1, 6>
» Logic Operators Graph Name (string):
+ Math Operations Label of the graph.
+ MotionAW Waveform 1 Name (string): -
B Name of the waveform 1.
+ MotionFX
' Mztizzﬁc Waveform 2 Hame (string):
. Name of the waveform 2.
* MotionID Waveform 3 Name (string):
+ MationMC Hame of the wavaform 3.
» MotionPW \Waveform 4 Name (string):
» Other Name of the wavefarm 4.
» Sensor Hub Waveform 5 Mame (string): -
" £ ek =
» Sequential Logic
3 Sigial d Properties g X
» Temperature Name Value Type
» UserInput Mumber of Curves 3 INT
» Vector Operations Graph Mame Acceleration STRING
Waveform 1 Name X axis STRING
Waveform 2 Name ¥ axis STRING
2 S t t' Waveform 3 Name Z axis STRING
. e proper Ies Unit Name [a] STRING
Zero axis position ENUM
Auto-scale Oon ~ | EMUM
Full Scale 4 STRING
Console 8 x
' ’ x:-18 y:-293 zoom: 1
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Console

[ Algo Builder GUI - * — ®
Fle Edt view Frmware Tooks  Helr
BEB A Q@ o BRX I ATL e i oo~ H @
\ Consar Magnitude
= ersion; 1.
’ g;’;i‘;’[s Calculates magnidude of the input vector,
+ Logic Operators Input Pins:
» Math Operations in (float x 3):
L MotionAW Input vector.
» MotionFX
4 - Output Pins:
" Maor. out (st 1
> MationMC Magnitude.
> MotionPW
» other
» Sensor Hub
> Seguential Logic
» Signal
» User Input TR A } 'I Accalaration
~ Vactor Operstions I ISWP&!?} | i
Magnitude
Normaiize
Add Magnitude function block
Properties & x
Name Value Type

" x: 173 y: -278 zoom: 1
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[ Algo Builder GUI - *

e

Qaaa vc BEXl

ITL Bco HE o~ i E

BEB#

5 x|

v Comparison
Eque_:l to (=)
‘Greater than (=)

Less than (<}
Less than or equal ko (<=)
Mot equal to (1=}

» Constants

» Display

» Graphics

» Lagic Opaerators

Math Operations

> MotionAW

» MotionFX

MotionGC

» MotionID

» MotionMC

> MotionPW

> Other

» Sensor Hub

> Seguentil Logic

Signal

User Input

Vector Operations

Vo v

Greater than or equal to (=)

P S g

Add Greater than (>) function block

Desaription a x

Greater than (=)

Version: 1.0 .
Checks if inl is greater than in2. Retumns 1 if the condition
Is true, O otherwise.

Input Pins:

inl (varantx 1):
First operand.

in2 (varant x 1):
Second operand:

Output Pins;
out (int x 1):
Result.

Properties & x

Console

Name Value Type

" x: 204 y: -299 zoom: 1
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Input Value (Binary)

[pot Valie 3

Input Value (Int)
Vectar Opergtions

3. Connect

1. Add Input Value (Float) function block

2. Set properties

[ Algo Builder GUI - * — O ®
Edit  View  Frmware Toos  Hel
BEAB A @aad sch@XlFaThL %% 8 ocone - I =

Lbrary - Dscription. & x
> Compatison Input Value (Float) Ll
+ Constants Version: 1.0 _

> Display get up to four flost values from Unideo-GUL

» Graphics :

+ Logic Operators Output Pins:

» Math Operations out (float x 1}

} MetionAW Output data.

» MotionFX i

: Properties:

* MotionGC Number of Values {int):

* MationID Defines number of values. Value must be from 1 to 4.

» MationMC Range: <1, 4>

> MotionPW Defzuit Value 1 (float):

+ Other Defines default value 1.

\ Default Value 2 (float):

g gzﬂzzl}r}t“:lbmlc Dafines default value 2.

. 4 Defzult Value 3 (floath:

» Signal Defines default value 3.

~ User Input Default Value 4 (float):

Defines default value 4,

Walue 1 Mame (string):
Label of the value 1.
Value 2 Name (string):
Label of the value 2.
Walue 3 Name (string):
Label of the value 3. —
Walue 4 Name (string):

Lahal nf the wvalus 4 hd

Console

Properties 8 x

Name Value Type
Number of Values 1 INT
Default Value 1 7 FLOAT
Default Value 2 0 FLOAT
Default Value 3 0 FLOAT
Default Value 4 o FLOAT
Value 1 Name Impact Threshold [g] STRING
Value 2 Name Value 2 STRING
Value 3 Name Value 3 STRING
Value 4 Name Value 4 STRING

” x: 236 y: 302 zoom: 1
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[ Algo Builder GUI - *

e

6 BB A aqaa o BEXl

GRS | ATl - IS

ITL Bce
» Comparison Pulse Width
> Consbamy Version: 1.0
» Display Measures pulse width.
» Graphics
+ Logic Operators Input Pins:
» Math Operations in (Int x ]_.}'.
» MotionAW Input sigral.
i Output Pins:
5 Motion&C M‘Tmn):
¥ MotioniD Pulse width in ms unit.
» MotionMC
> MotionPW FDW
» Other Graph 1 - - evel (int):
g Add Pulse Width function block || ozfneactve vl ofthe puise to messure.
» Sequential Logic Values: Negative, Positive
~ Signal
Darivatar
Feature Computation
FIR Fitar
Gain
IIR Fiter
Integrator
Moving Average
Peak Detector
Pulse Generator
?ube‘\rgﬁdth B
Signal Delay E
Zero Crossing Value Type
) User Inpus Level ]
> Mector Operstions —_——
Consols

K " x: 286 y:-289 zoom: 1
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[ Algo Builder GUI - * — O ®
Fle Edt View Firmware Took Help

HAD A @@ o BRX I SITL sce M Ghermm | & E

* Gompateny Greater than or equal to (>=)

) Version: 1.0

Greater than (>) ; Checks if inl is greater or equal than in2. Retumns 1 if the

Graster than or equal to (=) condition s true, Ootherwss.

Less than (<}

Less than or equal ko (<=) Input Pins:

Mot equal to (1=) m]#h_(stvaglgne;xné.}:
» Constants 3

5 in2 (varantx 1):
, gﬁplﬂ' Second operand.
» Graphics
. Liic Operaers Add Greater than or equal | ouputrns
» Math Operations put (int x 1):
P .
> MosonAw to (>=) function block as
» MotionFX
» MotionGC
» MotionID — = = -
' MotionMC I [Sensor Hub] H Accelera 'Iéi"m £ Magnituda F " . ~
S MotionPW = - - = i T
> Other f
» Sensar Hub |
> Seguential Logic Jl
> Signal .
> User Input !
> Vector Operations ]""E“t V:?"e /
Properties & x
Name Value Type
Console g x

" x: 207 y: -267 zoom: 1
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Input Value (Float)
Input Value (Int)
Vector Operations

v

3. Connect

1. Add Input Value (Int) function block

2. Set properties

] AlgoBuilder GUI - * - =] X
o Edt view Fmwerz Took  Hel
R acaa@ e BRXIE ST TL= %%le @ o
Lbzary B x| Description B x
Fitar: | [ Input Value (Int) =
+ Comparison Version: 2.00
+ Constants Get up to eight integer values from Unicleo-GUL
i Dﬁp":" Output Pins:
> Graphics out (intx 1)
+ Logic Operators Output data.
+ Math Operations
+ MotionAW Properties:
» MotionFX Window Name (string):
. : Title of the window.
> ngz:% Number of Values (int):
. Defines number of values. Value must be from 1o 8.
] Mot!unMC Range: <1, B>
* MationPW Default Value 1 (int): A
+ Other Defines default value 1.
» Sepsar Hub Default Value 2 (int):
+ Seguentizl Logic . 3 — Defines default value 2.
> Slgcrlwal = Magnitude F :l = F_,I Puke F :I B F Default Valie 3 (int):
. Temperature = ‘Width 7 Defines default value 3.
e i Default Value 4 (int):
User Topit Ve - Defines default value 4.
Input Value (Binary) - ! I = Default Value 5 (int):

Defines default value 5.
Default Value 6 (int):

Console

Defines default value 6. -
Pafanle 1 ral Fime
Properties g X
Name Value Type
Window Name Duration STRING
Mumber of Values 1 T
Default Value 1 10 T
Value 1 Name Impact Duration [ms] STRING

> /4

x: 211 y:-284 zoom: 1
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[ Algo Builder GUI - *

e Tools  Helr

AR A eaaa o BRXEATLE sce il G — W&

> Compatison Pulse Generator
+ Constants Version: 1.0
> DEIJE‘Y Genarate pulse with defined width.
» Graphics
+ Logic Operators _[nput Pins:
» Math Operations in (intx 1):
» MotionAW Trigger signal.
» MotionFX
- Output Pins:
> Mo‘t!unGC put (intx 1)
3 MotionID ‘Output signal.
» MotionMC
» MotionPW Properties:
> omet s ————
. afine the width of the pulse in ms unic
o gzzzl:ar[r}t“l.:lhwglc Walue must be greater than or egual to: 0
v Signal X v e
Derivatar Magnitude } :I 2. }_.I Pulse F I = F—’i _ Pulse F
Feature Computztion § _ Width g R
FIR Fifter i /
Gain | {
I Fier / 1. Add Pulse Generator
Integrator -
Hovng Aversge /' function block
Peak Detector
Puise Ganeratar
Pulse Width g x
nal Ded —
9 Y Value Type

v
g

g e 2. Set Width to 1000 —

> Mector Operstions

K " %461 y:-258 zoom: 1

life.augmented



Console

] AlgoBuilder GUI - * - =] X
sl
Description & x
Logic Analyzer =
+ Comparison Version: 2.0
. Copstants Displays up to eight logic values in realtime chart. The
~ Display X-3yis represents time, Y-axis & logic stste (0 or 1),
Bar n
. put Pins:
Fusion in{inEx 1):
Graph 1 - Add Loglc Analyzer Input data to display (y-axis value). The input data size
Histogram - has to match with number of channels.
togic function block _
Plat3D >
Seatter Nurrber of Channels (int):
valia Defines number of channels to plot. Value must be
from 1 to 8. =
- Gaphes 3. Connect Range: <1, 16>
» Logic Operators Logic Analyzer Name (string):
+ Math Operations Label of the logic znafyzer.
» MotionAW Channel 1 Name (string):
» MotionFX Labe| of the charnel 1.
» MotionGC Channel 2 Name (string:
. Label of the channel 2.
» Mot!unID Channel 3 Name (string):
* MotionMC Labe| of the channel 3.
> MotionPW Channel 4 Name (string):
» Other Label of the channel 4.
» Sensor Hub Ch.ar;].ﬂ?l Eyfmektﬁrinngz: s
» Sequentil Logic
> Signal Properties 5 X
» Temperature Name Value Type
Z SSECL In[z)ut i 2 S t t_ Mumber of Channels 1 INT
ector Uperations Logic Analyzer Name Logic# #Analyzer STRING
" e proper Ies Channel 1 Name Impact STRING

" x:-10 y:-239 zoom: 1
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I - O
e Edf Frmware  Tools  He
HEapFacaa o BXlE ot TL+~ scelili@E
Lbrary 8% Description & x
Fitter: | | Logic Analyzer =
+ Comparison \ersion: 2.0¢ "
» Constants H H 13 33 Displays up to eight logic values in real-time chart. The
o Save the design to default path with name “MyExample_2.xml Yais epresents tme, V-20s & b szte (0 or 1)
zr Input Pins:
sion 7 3
Save D ¢ ([0 (intx1):
Graph [ Save Design Input data to display (y-axis value). The input data sze
Hetogam I » Miroslav BATEK » STMicroelectronics » AlgoBuilder » Designs v 0 ¥l has to mateh with number of channels.
Plotan . Properties:
Sesitar Organize + Mew folder - o Number of Channels (int):
= ~ Defines number of channels to plot. Value must be
value (ad Mame Pate modifred Type Size from 1 to 8. =
+ Graphics 3 Quick access Range: <1, 16>
* Lagic Operators [ Exampled_Demaaml ) XML File Logic Analyzer Name (string):
+ Math Dperations [ Desktop + 1 ¥ Label of the logic znatyzer.
[ Exampled2_FeeeFallxmi HML Filie o
. MotionaAw  Downlosss # = Channel 1 Name {string):
+ MationFX |2 Example02_Tilt_Measurementaml XML File Label of the channel 1.
* MationGC Dacuments. A Q[ Exampleld_Filters XML File mLaar‘;l?IU? ?ha;n:hgﬁ;lglgz)'
+ MotionlD | Pictures + i Examplels Feature Computationxml KMIL Fiie Channel 3 Hama (string):
» MotionMC ) . P Label of the channal 3.
© MotionPW Designs @{ Examplelf_ZeroCrossing_PeakDetectars.. WML File Channel 4 Name (string):
+ Other Dcitiesration m Examplel7_Algorithms_|ntegrationaml HML File ChLBbE| Iugﬁ'le d‘lilig'tl'lﬁ "3:
¢ Sensor Hub : IJ Example08_6D_Detectionxml KMIL File {ar.]‘n;e —u.amfs. 5 F:‘ =
. Sequentsl Logic SW_AlgoBuilder = —i=hal —
» sigral R CUBE NG | Example0d Tilt Using Gyrosml KML Fite |—F_mpu(ﬁe.f. A%
> Temperatura [ Bxample10_FFTaml XML File Neite Valua Type
sﬁﬂr Input = This PC [ MyExample_1axml B1235PM XML Filie Mumber of Channels 1 T
actor Operations = i .
W Deskiop L MyBxample 2l 18 1047 AW XML File gifniﬁﬁﬁ:; Pé'ame Jl-;%fft#ﬁnmef iﬁg
&) Docurmests _|._:‘[ MyExample Jxml 3018 1054 AM . XML File
810424 XML Fit
$ Gicurdos [ MyExample_4xmi 18104240 XML File
J’ Music
[ Pictures L
Fl’lagamz MyExample_2xml v
Save as type: | Tum| >
~ Hide Folders

life.augmented



[E] AlgoBuilder GUI - MyExample_2m|

S

=

8 oo res - b 5 E

o BEXIFaTTL+ B4

H"tﬁf'. |

+ Comparison
» Constants
v Display
Bar
Fusion
Graph
Histogram
Logic Analyzer
Plot3D
Seatter
Value
Graphics
Lagic Operators
Math Dperations
MationAW
MationFX
MationGC
+ MationID
MationMC
MationPW
QOther
Sensor Hub
Sequential Logic
Signal
Temperature
User Input
Vector Operations

VW W W W W W

1. Click on Build Firmware

S

=} [ =

[ tserso by ] Accslemion

2. Wait for compilation
3. Check that the code was compiled without error

— O X
Desarptior 8%
Logic Analyzer =
Version: 2.0:

Displays up to eight logic values in real-time chart. The
X-axis represents time, Y-zxis & logic stste (0 or 1).

Input Pins:

in(imtx 1)
Input data to display (y-axis value). The input data size
has to mateh with number of channels.

Properties:

Nurnber of Channals (int):
Defings number of channels to plot. Value must be
from 1 to 8.

Range: <1, 16>

Logic Analyzer Mame (string):
Label of the logic anafyzer.

Channel 1 Name (string):
Label of the channal 1.

Channel 2 Name (string):
Label of the channel 2.

Channel 3 Name (string):
Label of the channal 3.

Channel 4 Name (string):
Label of the channel 4.

Channel 5 Mame (string):
Lobal af tho cb s

Console

—
arm-none-egabi-objcopy -0 binary "STM32L4:0-Nucleo-Project.elf” "STM32L4xx-Nucleo-Project.bin” & arm-none-eabi-sze —format=berkeley STM32L4x0-Nucleo-
Project.elf

text data bss dec hex filename
169464 5752 46632 221848 36298 STM32L4:xx-Nucleo-Project.elf

13:27:24 Build Finished (took 45.583ms)
Invoking scanner config builder on project
Build Process Finished

Exit Code: 0

|

Properties 2 X
Name Value Type
Murmber of Channels 1 T
Logic Analyzer Name Logic##Analyzer STRING
Channel 1 Name Impact STRING

" x: 70 y: -285 zoom: 1
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13:27:24 Build Finished (took 45.583ms)
Invoking scanner config builder on project
Build Process Finished

Jraion

FW binary file programed successfully!

IDE: SW4STM32 Target: STM32L476RG Drive: D: NODE_L476RG

3. Wait till the board is programmed

[ AlgoBuilder GUI - MyExample_2xml - m] b
BAAB A aAQQ@ o BEX -t TL~ %%% #e.@ﬁ-}wﬁ!ﬁ-‘gl@l@
by B x —_— Desaption & %
: ' ogic Analyzer =
Fiter: | % . Logic Anal
+ Comparison Version: 2.0:
- Comoarss 1. Connect STM32 Nucleo to your PC 4. Open Unicleo-GUI ||y 20 s niesbime char. The
v Display X-axis represents time, Y-zxis & logic stste (0 or 1).
Bar H
B 2. Click on Program STM32 Nucleo Topt Vi
%
Graph Input data to display (y-axis value). The input data size
Histogram has to match with numbaer of channalk,
Logic Analyzsr §
P30 Properties:
Scatter Nurnber of Channals (int):
i Defings number of channels to plot. Value must be
value from 1 to 8. =
+ Graphics Range: <1, 16>
+ Logic Operators Logic Analyzer Mame (string):
* Msth Dperations Labal of tha Iog(ic analyzar.
+ MotionAW = y Acceleration Channel 1 Name [string}:
i I ISty fal Lzbel of the channel 1.
. MationGC Channel 2 Name (string):
Label of the channel 2.
+ MotionlD Channel 3 Namea (string):
+ MationMC Label of the channal 3.
» MotianPW Channel 4 Namie (string):
» Other Label of the channel 4.
> Sensor Hub Chlallﬂ?' Eﬁ?mek(s‘:rin.gz: <
» Sequentil Logic -
> Signal Properties & x
» Temperature Name Value Type
» User Input Mumber of Channels 1 T
» Vector Operations Logic Analyzer Name  Logic##Analyzer STRING
Channel 1 Name Impact STRING
Console & x
text data bss dec hex filename -
169464 5752 46632 221848 36298 STM32L4xx-Nucleo-Project.elf

) /4

x: 286 y: -285 zoom: 1
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k3 Unicleo-GUI

1. Check the boards is connected to Unicleo GUI

Se=tDmnr [Cﬂl'dﬁ

F Comect

| Start

Stop | .+ Settings | X Exit
Info FW Management User Messages TKS0142 Options

H.

2. Click Start to run the application

3. Open all windows

A E I kX XXXl

asncensnoenonsnses

| STMicrosiectranics Unicleo Version:  L.4.5.6406 Firmware Version = 5.0.0

1S7;

fe.augmented
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augmented

1. Test the functionality.

¥4 Acceleration

10[g}

5[a]

3 Logic Analyzer

[ [ e D

k3 Unicleo-GUI
|C{'.rl\'lﬁ |:] Corn o Disconnect | Start
Info FW Management Uiser Messages TES01AZ Ophions

|__] Time Stampllol&ccelssacion [Egl] |
Diatalog | L% sxis | X axis |2 sxisz |
aj 0.0800a60] 0.023000] 106250001
a1 4.033000) 9.033000) 1. 00€000)
al 0042000 -gz1o00] 1_A18000
al 0-g4z000| 0-gzs000| 1038500
aj 0.042000] 0.G31000] 1051000
a1 a.044000) 4.033000) 1.p70000)
2l 0.0%&000] 0.030000] 1474000
al 0-Q44000] o-gL7o0d| 10450001
a) 0.042000] 1.002000]
a1 4.040000) -4, 4.883000)
al a_o400aa] -a 8 _8£3000
al o-gaznno | -a 0552000
aj 0. G2E060] -1 0.570000
Buration aj) 4.024000| -2 0.885000)
al -G3606a 4_go0a0aa] 1_ 801000
al 0-gacoao | -0 061000 | 1046000 |
aj 0.0440060] a 107100601
a) a.032000) 1084000
al -833000 4.o13000] 1_@E8000]
al 0-g4s0a0 | 0-ga7oodl 1052000
aj 0.0 2000 | 1.043000]

a) a.021000) 1

al 4.811000] o

al 0-QoBooa| 0-

aj 7000 0.

a1 a.011000) a.030000) 1

al 0015000 0.036000] h i

al 0-Qzzooo | 0-033000 I
13:33:10.83| 9| 0.@210a0] 0.@270a0] 1.045000]

STMicroslectronics Unicleo Verzion:  1.4.5.6408

| Threshold *

Impact Threshod g

| Duration X

mpact buration (e

2. Close Unicleo-GUI when you finished the testing.




Demo 3
FFT Analysis




Algo Builder GUI* - O K
g

Took  Help

W BB S ecaa se BAXETL 525006 @ FEwE @

iy 8 x

> Comparison N

» Constants H H
e Click on New Design
» Graphics

» Logic Operators
» Math Operations
> MotionAW

> MotionFX

» MotionGC

» MationID

> MotionMC

> MotionPW

» Other

» Sepsar Hub

> Seguential Logic
» Signal

> User Input

» Neckor Operstions

Properties & x

Name Value Type

Console g x

" x:-119 y: 134 zoom: 1
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[ Algo Builder GUI*

BEAB S Qa8 S BRXE ITL s N @ Ew W G

Library &% Description & x
» Comparison

» Constants

» Display

» Graphics

+ Logic Operators
» Math Operations
> MotionAW

+ MationFX
ﬂ:g::%z E] Firmware Settings [:? >4
. Mot rovareloaton 1. Browse for C:\AlgoBuilder\MyExample_3 directory
> Sense;rHuh |E:MlgoBquer}MyE)anJa_2 || ‘Browse: |
» Seguential Logic 5
» Signal Toolchain [ TDE
» User Input

> Vector Operasors SWasTM32 ~| 2. Select compiler SW4STM32

Target

| NUCLED-L476RG ~| | ek || cancal |

3. Select Target NUCLEO-L476RG 4. Click OK

Properties 8 x

Name Value Type

Console g %

" x:-119 y: 134 zoom: 1
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v Sensariuh 1. Place [Sensor Hub] to workspace
[ i
Acceleration [g]

Angular Rete [dps]
Humidity [percant]
Magnetic Feld [uT]
Pressure [hPa]
Temparature [°C]

Sequential Logic

Signal

User Input

Vector Operations

R

2. Change Accelerometer Full Scale to 49 —
3. Output Data Rate ODR 100Hz

[ Algo Builder GUI - * — O ®
Fle Edt view FEmmware Tooks  Hel
AR A Q@ oc BRX I SATL Bce 8 oros - @

Lbrary _ 8x ‘Desarition ax
» Comparison [Sensor Hub]

> Constatits Version: 1.0

» Display Sensar Hub provides links to sensor and algorthms in order
» Graphics to retrieve data from them,

+ Logic Operators

» Math Operations Cutput Pins:

> Motinn:w put (void x 1):

» MotionFX Sensaor Hub handler,

» MotionGC

> HationD Data Rate (inth:

» MotionMC Defines the sensor's and algorthm's data rate in Hz.

» MotionPW Range: <1, 400>

» Other accelerometer Ful Scale (int):

Defines the accelerometer full scale.
Values: 2 g, 40,80, 160
Gyroscope Full Scale (intl:
Defines the gyroscope full scale.
Values: 245 dps, 500 dps, 1000 dps, 2000 dps

Properties 8 x
Name- alue Type
|Data Rate Contral Timer ~ [ENUM
P Data Rate 103 CINT
#ccelerometer Full e 4g * EPLM
Gyroscope Full Scals 500 dps ~ EFLM

Console

” x: 481 y: 302 zoom: 1
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Console

£ Alge Builder U - * - P
Fle Edt View Firmware Took Help
. b1 I - ——————— |

BEB A aaa@ o BRX I ATL e il Ghaee - =
LUbrary 8% Desaription 8 x
> Compatison Acceleration [g]
» Constants Yersion: 1.0
» Display Retrigve the accelerometer data.
» Graphics
» Logic Operators Input Pins:
» Math Operations SensorHubHandle (void x 1):
» MotionAW ‘Connect to Sensor Hub output.
» MotionFX

- Output Pins:
* MotionGC dats (float x 3): o
+ MotionID Accelerometer data (acceleration) in g unit.
» MotionMC
> MotionPW
» other - .
v Seerin Add Acceleration [g] function block

[Sancar Hub]

Acceleration [g]

Angular Rate [dps] I ¢ Hub] Acceleration

Humidity [percant] L el gl

Magnetic Feld [uT]

Pressure [hPa]

Temparature [°C]
> Sequential Logic
> Signal
> User Input
» Vector Operations

Properties 8 x
Name Value Type

" x: 60 y:-292 zoom: 1

=.augmented




] AlgoBuilder GUI - * - =] X
R A e e BRX I T TL+~ gceo il 85
Lbzary. B x| Description Bx
Fiter: | | Graph E=
» Comparison Version: 2.0° . )
» Constants Graph. Displays up to sox realtime curves. The X-axis
v Display represants tma, Y-axs i value,
Bar n|
: put Pins:
Fusion in {varant x 3}
Graph Input data to plot (y-axis value). The input data sze
Histogram has to match: with number of curves.
Logic Analyzer
Lok Kech 1. Add Graph function block Proparties
Settar Nurrber of Curves (inth:
valia Defines number of curves to plot. Value must be from
Lto 6.
» Graphics Range: <1, 6>
» Logic Operators Graph Name (string):
+ Math Operations Label of the graph.
+ MotionAW Waveform 1 Name (string): -
B Name of the waveform 1.
+ MotionFX
' Mztizzﬁc Waveform 2 Hame (string):
. Name of the waveform 2.
* MotionID Waveform 3 Name (string):
+ MationMC Hame of the wavaform 3.
» MotionPW \Waveform 4 Name (string):
» Other Name of the wavefarm 4.
» Sensor Hub Waveform 5 Mame (string): -
" £ ek =
» Sequential Logic
3 Sigial d Properties g X
» Temperature Name Value Type
» UserInput Mumber of Curves 3 INT
» Vector Operations Graph Mame Acceleration STRING
Waveform 1 Name X axis STRING
Waveform 2 Name ¥ axis STRING
2 S t t' Waveform 3 Name Z axis STRING
. e proper Ies Unit Name [a] STRING
Zero axis position ENUM
Auto-scale Oon ~ | EMUM
Full Scale 4 STRING
Console 8 x
' ’ x:-18 y:-293 zoom: 1
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Fle Edt Vew Frmiare Toos e

REAR L ¢ Bl Xl

It Hh+@qaa SRS L

“ [votFound - H Q. @

&%

0 Buffers
 Comparison
t Constants
+ Display

4 FFT

i Graphics

+ Library Name

* Logic Operators

"+ Math Operations

+ MationAW

I MaotionFX

I+ MotionGE

[+ MotionID
MotionMC

* MotiorPW

+ Giher

! Pressure

+ Sensor Hub

+ Sequential Logic

I+ signal

I Temperature

i+ User Input

I Vector Operations

T
FFT Peak Detector

3. Connect

1. Add Demux Float function block from the Other Library

2. Set properties 3 outputs

Demux (Float)
Version: 1.0

Float demultiplexer. Creates individual scalar outputs from input array.

Input Pins:
inl (float x 3):
Input.

Output Pins:
outl (float x 1):
Output 1.
out? (fioat x 1):
Output 2.
out3 (float x 1):
Output 3.

Properties:
Number of outputs {nt):
Range: <2, 16>

Console

Properties F X

Name Value Type

Name Value Type
Mumber of outputs 3 INT

Lys
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Fle Edt Vew Frmiare Toos e

REAR L ¢ Bl Xl

1 TL= Qa®QQ e HE b e @

&%

0 Buffers
 Comparison
t Constants
+ Display

4 FFT

FFT
FFT Peak Detector
i Graphics
+ Library Name
* Logic Operators
"+ Math Operations
+ MationAW
I MaotionFX
I+ MotionGE
[+ MotionID
MotionMC
* MotiorPW
+ Giher
! Pressure
+ Sensor Hub
+ Sequential Logic
I+ signal
I Temperature
i+ User Input
I Vector Operations

1. Add 3x FFT function block from the FFT Library

3. Connect

| 4 T

2. Set propefties 256 data length

FFT
Version: 1.0
This block collects data into buffer and if buffer is full computes FFT.

Input Pins:
in (float x 1):
Input data.

Output Pins:
out (float x 512):
Outputin the frequency domain.
size {intx 1)
Buffer Size.
full {int x 1):
Buffer full flag. Returns 1if the buffer is full, 0 otherwise.

Properties:
Data length {float):
Values: 32, 64, 128, 256, 512, 1024
Window Type (int):
Values: Mone, Hanning, Hamming, Flat Top

Console

Properties F X
Name Value Type
Data length 256 - ENUM
Window Type Mone - ENUM

Lys

life.augmented




File  Edit View Firmware Tools:  Help

Lrary #x
Firter: [x]

BEBF 5c Bl Xl

It Hh+@qaa SRS L

| 40 [otround

i = E

i Buffers

Comparisan
* Canstants
+ Display
FFT

=

FFT
FFT Peak Detector

i Graphics

+ Library Name

* Logic Operators

- Math Operations

+ MationAW

I MaotionFX

I+ MotionGE

[+ MotionID
MotionMC

* MotiorPW

+ Giher

! Pressure

+ Sensor Hub

+ Sequential Logic

I+ signal

I Temperature

i+ User Input

I Vector Operations

1. Add 3x FFT Plot function block from the Display Library

3. Connect

mux Bl
a

2. Set properties 256 data length & Full Scale 1

FFT Plot

L

:

Version: 2.0
Displays FFT plot.

Input Pins:
in (float x 512):

Input in the frequency domain.

Properties:

Flot Name (string):
Label of the plot.
Data length (float):

Values: 32, 64, 128, 256, 512, 1024

Units (string):
Vertical axis units,
Auto-scale (nt):
Auto-scale enabled.
Values: OFF, OM
Full Scale (string):
Plot full scale.

Properties

Console

Name Value
Plot Mame Z axes
Data length 256
Units
Auto-scale OFF
Full Scale 1

Type
STRING
v ENUM
STRING
~ ENUM
STRING

Lys
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Fle Edt Vew Frmiare Toos e

REAR L ¢ Bl Xl

It Hh+@qaa SRS L

“ [votFound - H Q. @

ey 8%
Firter: [x]

0 Buffers
 Comparison
t Constants
+ Display

4 FFT

FFT
FFT Peak Detector
i Graphics
+ Library Name
* Logic Operators
"+ Math Operations
+ MationAW
I MaotionFX
I+ MotionGE
[+ MotionID
MotionMC
* MotiorPW
+ Giher
! Pressure
+ Sensor Hub
+ Sequential Logic

I+ signal
I Temperature
i+ User Input

 Vector Operations

2. Set properties 256 data length

3. Connect

1. Add 3x FFT PEAK function block from the FFT Library

FFT Peak Detector
Version: 1.0
This block detects maximum amplitude in the frequency spectrum.

Input Pins:
in (float x 512):
Input data.

Output Pins:
amplitude (float x 1):

Maximum amplitude in the frequency spectrum.
frequency (float x 1):

Frequency with the maximum amplitude.

Properties:
Data length (float):
Values: 32, 64, 128, 256, 512, 1024
Exdude DC (nt):
Exdude DC component from maximum amplitude evaluation.
Values: NO, YES

Console

Properties g x
Name Value Type
Data length 256 * ENUM
Excude DC NO ¥ EMUM

Lys
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E GUE-*
_Fue Edit  View Firmiare Mol Help

BEAB L 5 Bl X

“lmtmd 'H Q@

It Hh+@qaa SRS L

8%
[x

0 Buffers
 Comparison
t Constants
+ Display

4 FFT

FFT
FFT Peak Detector
i Graphics
+ Library Name
* Logic Operators
"+ Math Operations
+ MationAW
I MaotionFX
I+ MotionGE
[+ MotionID
MotionMC
' MotionPiy
+ Giher
! Pressure
+ Sensor Hub
+ Sequential Logic
I+ signal
I Temperature
i+ User Input
I+ Vector Operations

1. Add MUX float function block from the Other Library

P 6]
*(Float)

YYVYVY

2. Set properties 6 inputs

3. Connect

Console

Mux (Float)
Version: 1.0
Float multiplexer. Creates array from scalar inputs.

Input Pins:

inl (float x 1):
Input 1.

in2 (float x 1):
Input 2,

in3 (float x 1)
Input 3.

in4 (float x 1):
Input 4.

in5 (float x 1):
Input 5.

in6 (float x 1):
Input &,

Output Pins:
out {float x 6):
Output.

Properties:
Mumber of inputs (int):
Range: <2, 163>

Properties

Name Value Type

MNumber of inputs [

Lys
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Vew Frmaare ol  Help

BEB A s BEXI- -l TL- QaQa R N Qe s @

Library &% | Desgripgon i
Fiter: [
Value
i Buffers Version: 2.0
\ Comparlson Displays up to eight integer values.
" Constants Input Pins:
" Display in (variant x &):
4 BT o - - Input data to display. The input data size has to match with
number of values,
T inmn 1. Add MUX float function block from the Other Library
4 Properties:
q E’;ﬂ' e Number of Values fint):
k Ay Name Defines number of values to display. Value must be from 1 to 8.
 Logic Operators Range: <1, 8>
! Math Operations Window Mame (string):
I MationAW Label of the values window.
b ¥ Value 1 Name (string):
Wiz Label of the value 1.
& MotionGE Value 2 Name (string):
* MotionID Label of the value 2.
I MotionMC Value 3 Name (string):
> MotiorBi Label of the value 3.
{ Value 4 Name (string):
% St Label of the value 4.
Pressure Value 5 Name (string):
I+ Sensor Hub Label of the value 5.
I+ Sequential Legic Value 6 Name (string):
il Label of the value 6.
£ Value 7 Name (string):
Trptate Label of the value 7.
User Input Value 8 Name (string):
[+ Vector Operations Label of the value 8.

Unit 1 Name (string):
Unit of the value 1.

Properties F X
Name Value Type
Number of Values [ INT
Window Name Values STRING
Value 1Mame * STRING
Value 2 Mame Xpeak STRING
- Value 3 Name ¥ STRING
2. Set properties 6 values and the labels vsuesneme Y pesk sTeanG
Value 5 Mame Zpeak STRING
Value 6 Name z STRING
Unit 1 Name Unit 1 STRING
Unit 2 Name Unit 2 STRING
3‘ Con neCt Unit 3 Name Unit 3 STRING
Unit 4 Name Unit 4 STRING
Console & %/ Urit 5 Name Unit 5 STRING
Unit & Name Unit & STRING

) /4
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File Edit View Frmware: Tools: Help

B BB A oc bl Xl

1T Th+|@Q @ gkl

[tbrary &%
Fiter: [x

- 1.-Connect STM32 Nucleo to your PC

" Logic Operators
© Math Operations

: ool 2. Click on Program STM32 Nucleo

I» MeotionGC
MotionID
I MobonMC
© MobonPyW
4 QOther
Counter
Demux (Float}
Demux {Int)
Feedbadk (Fleat)
Feedback (Int)
Float To Int
IntTo Float
Mux (Float)
Mux {Int)
Swntch (Float)
Switch (Int)
Pressure
Sensar Hub

>

Acceleration [a]
Angular Rate [dps]
Humicity [perzent]
Magretic Field [uT]
Pressure [hPa]
Temperature [C]
Timestamp [ms]

Sequential Logic
Set-Reset Fiip Flop

Signal
Derivator
Feature Computation
FIR Filter
Gain
IR Filter
Integrator
Moving Average
Peak Detector
Pulse Generator

9

S

4. Open Unicleo-GUI

Pulse Width Console:

Signal Delay make ~no-print-directory post-buid
Zero Crossing Generatng hinary:

4 Temperature.
Calsius 1o Fahrenteit TEXT data bes e hex
Fahrenhelt ta Celsius 280632 5776 71536 357944 57538

4 User Input
Input Value (Binary)
Tnput Value (Float)
Input Value {Int)

4 Vector Cperations
Magritude FW binary file programed successfully!

Normalize IDE: SWASTM3Z Target: STM3AL476RG Drivet D: NODE_L476RG

ename
STM32L 4xx-Mucleo-Project.eif

27:26:18 Bulld Finished {took 455, 439ms)

Invoking scanner config builder on project

ISESSION 2018-10-2522:25:22,445 ——————————————————
Bulld Process Finished

arm-none-sabl-objeopy -0 binary "STM32L4xx-Hudes Project.elf” "STM32 4uc-tudeo-Project.bin” & arm-none-sabi-size. ~format=herksley STM32Loc-hudeo-Project.ff
3 il

| 3. Wait till the board is programmed

&

Value T

%213 vi 494 zoom: 1
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1. Check the boards is connected to Unicleo GUI

e 13U

CoMTE Comect | % Distonnect J St=t W\ Stop ‘ - settings \ M Exit
[ Info | FW Management | UserMessages | IKSOIAZOptons |
ﬂgig 2. Click Start to run the application
=
Zaxes
E ===
= i
o : b
Kanes £ 2
£ : 2
¥ axes € 3
.
{4
visualization
_I;ﬂ;.ﬂ-l.!l‘!"'.i-l-ﬁﬂ-ﬂ'.‘ﬂﬁ'll u'ﬁi
‘mesesssssssssssssss

STMiceeleciranics Liniclen Version: 1,410,569 Firmware VYersion = 5,0.0 Expansion Board: IKSD1A2




1. Test the functionality.

2. Remove the DC
3. Move the board
4. FFT , check the peak and frequency

k3 Unicleo-cUl o

SelectPort: | "l Briree 5 e |

[ Info | FW Management _; User Messages |

Time Stamp|Values
|¥elue 1 [Unic 1|Welue 2 [Undis

23:04-31 54
23:04-32 01|
23-04:-3Z2_08]|
02:32 16|

0. 000004
a.o0000
00000
_ooood
iugefalula]
Soooog
+00agay -1 Qutput Data Rate: Magnitude: 500 m

&.o0oan ‘

z
2
2
Z
z
£
4
Z

5 _g000d8

25 000004 | FFT Samples: Display Mode: Bars
25 +00000 ey : | E DC Nulling

25 L0000 : i

25 _oooaa —

25 LOaoa0f

25 L00000

0000y

_aonoo (e

pyugeieiafal)

paiaieial} !

connoo ] Peak and
_aooas 350 E

ouono ) frequency

J0a0og

ot

L A

[AERR R
i
RERE RS RS RE R

0o in

oo

-
3
9
5
3
-
9
5
3
2
L
5
3
3
9
5
3
3
=
5
-
3
]
5
3
3
=

£_25 +oaoooy
23:04:-33.74| 2 35 . g0oan
23:04-33.81| £_25 O .000001
23:-04:-33.87| 2225 [<Bg e elelele]
Poxg:- COM7TS Closed 0 1 2 5 E 5

e . ) " Frequency [Hz]
| ] | Output Data Rate: 1o0 Magnitude: ~ 500 m Output Data Rate: Magnitude: 500 m
1 — FFT Samples: 1024 Display Mode: Bars FFT Samples: Display Mode: Bars FFT
STaodechancs i\ B DC huling DC Nulling

> /4

augmented

Remove the DC



ST MEMS complete software solution

From drivers to software development tools

Low-level Drivers

Standard C Platform
Independent drivers
Windows drivers Development Tool
Li dri ba_sed on Low level
Inux drivers drivers Generic SW libraries AlgoBuilder Tool
Runs on STM32 Accuracy, Calibration, :
b Sample implementation |I?|03||tt|rc]>n|ng,lf\c.’uwty tracking, ?edll(f:atelqbsof_tware
Lisitre of device embedded ealth monitoring dOO IOI" I ratrles
’ features Dedicated SW libraries | 9€V€lopmen
P Graphical design apps to
[ 3 — build and use algorithms
al S| 999
MEMS and Sensors Software - e
| OGO
‘ Go to st.com
” Open.MEMS - STMicroelectronics
e augmentes Go to ST.com




Takeaways

Internet of Things offers many opportunities for ST

from Sensor to Cloud )
ST has all the building blocks for the loT
« MEMS and Analog portfolio from consumer to industrial
applications \_/

» AlgoBuilder allows fast proof of concept of Sensor based

algorithms

We keep the commitment on MEMS innovation @ ﬁﬁj ’_
- .7.?—7.;;7:}. ] ”

Our constantly expanding development ecosystem
makes design fast

fe.augmented



ST Community — Mass Market Support

Allplaces > MEMS apd.Sansers Ch minmity - : B /
MEMS and Sensors Forum y PR | S (S

Activity Content People Subspaces Reports

CATEGORIES

All Content (1075) g Bleg Posts (0) Bl pocuments{4) B Discussions (11) 2] Questions (1062) EF videns (0)
MEMS Microphones

Mass Market Support: MEMS Forum

For more information on sensors: www.st.com/sensors

Information on longevity: 10yr Longevity Program

Android / Linux / Open Drivers: Drivers for MEMS




Thank You!
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© STMicroelectronics - All rights reserved

The STMicroelectronics corporate logo is a registered trademark
‘ of the STMicroelectronics group of companies
" All other names are the property of their respective owners
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